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History of GIS: Early History of Mapping and 

Cartography in Bangladesh 

Md. Abeed Hossain Chowdhury, Project Manager, Crop Zoning Project 

Bangladesh Agricultural Research Council 

Email: abeedchowdhury@gmail.com 

 

Introduction 
 

Geographic Information Systems (GIS) and cartography have played a crucial role in 

Bangladesh’s development, from early colonial land surveys to modern satellite-based 

geospatial analysis. 
 

 

1. Pre-Independence Era: Colonial Surveys (1760–1947) 
 

Key Developments: 

• 1760s–1800s: The British East India Company conducted the first systematic land 

surveys for taxation and revenue collection (e.g., Cadastral Surveys). 

• 1850s: The Great Trigonometrical Survey of India (under Sir George Everest) 

established geodetic control points in Bengal. 

• Early 1900s: Topographic maps were created for military and administrative purposes, 

often hand-drawn with limited accuracy. 

Legacy: 

• Many colonial-era maps are still used as reference documents in land disputes. 

• The District Gazetteers included early geographic and demographic data. 
 

2. Post-Independence: Early Modernization (1947–1971) 
 

Key Developments: 

• 1950s: Establishment of the Survey of Pakistan, which continued cadastral and 

topographic mapping. 

• 1960s: Introduction of aerial photography for floodplain and riverine mapping. 

 

Limitations: 

• Manual cartography dominated, with slow updates. 

• Limited accessibility of maps for civilian use. 
 

3. Birth of GIS in Bangladesh (1971–1990s) 
 

Key Milestones: 

• 1973: Creation of the Survey of Bangladesh (SOB), responsible for national mapping. 

• 1980: Establishment of SPARRSO (Bangladesh Space Research and Remote Sensing 

Organization), introducing satellite remote sensing. 

• 1989: First use of Landsat imagery for flood monitoring. 

 

Early GIS Applications: 

• Disaster Management: Cyclone and flood mapping. 

• Agriculture: Crop monitoring using NOAA AVHRR data. 

mailto:abeedchowdhury@gmail.com
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4. Digital Revolution (1990s–2010s) 
 

Key Advancements: 

• 1991: First digital topographic maps developed by SOB. 

• 1997: Digital AEZ map and digitized LRIS by BARC 

• 1998: Launch of Bangladesh’s first GIS-based land record system  

(DLRS – Digital Land Record System). 

• 2000s: 

• Google Earth (2005) increased public access to geospatial data. 

• River erosion studies using RS and GIS gained importance. 

 

Institutional Growth: 

• Bangladesh Agricultural Research Council (BARC) adopted GIS for soil mapping. 

• Local universities (e.g., BUET, KU) introduced GIS courses. 
 
 

5. Modern Era (2010–Present): AI, Drones, and Big Data 
 

Recent Developments: 

• 2013: Bangladesh Satellite-1 project initiated (launched in 2018). 

• 2016: Digital Bangladesh Vision promotes GIS for smart agriculture & urban 

planning. 

• 2020s: 

• Drone-based land surveys by SOB. 

• AI-powered flood prediction models (e.g., using Sentinel-1 SAR data). 

 

Key Applications Today: 

✓ Disaster Management: Real-time flood mapping (e.g., FFWC uses GIS). 

✓ Agriculture: Soil test-based fertilizer recommendation (Khamari App). 

✓ Urban Planning: Dhaka’s Detailed Area Plan (DAP) uses GIS. 
 
 

6. Challenges & Future Directions 
 

Persisting Challenges: 

• Fragmented data across agencies (SoB, BARC, LGED). 

• Limited open-data policies. 

• Shortage of skilled GIS professionals. 

 

Future Opportunities: 

• National GIS Policy for data standardization. 

• Expansion of drone & IoT-based mapping. 

• Integration with AI (e.g., automated land classification). 
 
 

Conclusion 
 

From colonial land surveys to AI-driven geospatial analytics, Bangladesh has made 

remarkable progress in GIS and cartography. With continued investment in satellite 

technology, digital infrastructure, and workforce training, Bangladesh can leverage GIS 

for sustainable development, climate resilience, and smart agriculture. 
  



5 | P a g e   

Provide an Overview of using Geospatial Data for 

Effective Monitoring, Evaluation, and Resource 

Management 

 
Mohammad Manjur Mahmud 

President, DataSoft Systems Bangladesh Ltd. 

Email: manjur@datasoft-bd.com 

 
Data Acquisition and Advanced Sources 

This is the foundation of any powerful spatial M&E system, focusing on acquiring location-

specific, high-quality data. 

Advanced Remote Sensing Platforms 

Remote sensing provides large-scale, repeatable coverage for change detection. 

▪ High-Resolution Satellite Imagery: Used for detailed land use mapping and asset 

verification. 

▪ Commercial (e.g., Maxar): High spatial resolution (sub-meter) but costly. 

▪ Public (e.g., Sentinel, Landsat): Lower spatial resolution (10–30 meters) but free, with 

high temporal resolution (frequent revisit times) essential for time-series analysis. 

▪ UAV/Drone Imagery: Provides on-demand, extremely high-precision data for small 

areas (e.g., measuring construction volumes or assessing immediate disaster damage). 

▪ LiDAR and Radar (SAR): 

o LiDAR (Light Detection and Ranging) creates accurate 3D models (Digital 

Surface/Terrain Models - DSM/DTM), vital for flood modeling and biomass 

estimation. 

o Radar (SAR) penetrates clouds and works day/night, making it essential for 

monitoring changes in forestry, agriculture, and flood extent, regardless of 

weather. 

In-Situ & Mobile Data Collection 

This involves ground-truthing and collecting data directly in the field with precise locations. 

▪ GNSS Integration (GPS/Galileo): Ensures all collected field data is accurately 

georeferenced. 

▪ Mobile GIS Applications: Tools like Survey123 or KoboToolbox allow staff to collect 

structured data in the field (photos, attributes) that automatically integrate into a spatial 

database in real-time. 

Big Data & Cloud Processing 

Leveraging cloud infrastructure to handle massive datasets. 

▪ Google Earth Engine (GEE): A powerful platform for large-scale, multi-temporal 

analysis (e.g., monitoring deforestation rates across an entire country over two decades 

without needing to download terabytes of data). 

▪ Integration with IoT/Sensor Data: Linking real-time sensor measurements (e.g., air 

quality, water flow) to their geographic location for continuous, spatial monitoring. 
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Advanced Spatial Analysis for M&E 

This section details how to transform raw spatial data into meaningful metrics for evaluation. 

Change Detection and Trend Analysis 

Used to quantify the impact of an intervention over time. 

▪ Multi-temporal Imagery: Comparing satellite images from before (baseline) and after 

(endline) an intervention to quantitatively measure change (e.g., calculating the area of 

new forest grown in a reforestation project). 

▪ Time Series Analysis (NDVI/NDWI): Analyzing trends in spectral indices like 

Normalized Difference Vegetation Index (NDVI) to monitor crop health or Normalized 

Difference Water Index (NDWI) to track water body fluctuations. 

Geostatistical Analysis 

Techniques used to understand patterns and spatial dependency. 

▪ Hotspot Analysis (Getis-Ord Gi): Identifies statistically significant clusters of high or 

low values (e.g., finding areas with an unusual concentration of disease cases, or project 

beneficiaries). 

▪ Interpolation (Kriging): Creates a continuous surface of predicted values from a 

limited set of sample points (e.g., estimating soil nutrient levels or population density 

across a whole region based on field samples). 

Network and Proximity Analysis 

Analyzing relationships between locations based on distance, time, and connectivity. 

▪ Service Accessibility: Calculating the actual travel time (not just straight-line distance) 

to essential services (e.g., nearest clinic or school) to evaluate equity in service delivery 

and identify underserved populations. 

▪ Optimal Resource Placement: Using GIS modeling to determine the best strategic 

location for a new facility (e.g., a distribution center or health post) based on existing 

infrastructure, population need, and terrain. 

 

Resource Management Applications 

Practical, high-impact use cases where spatial data drives efficiency and sustainability. 

Natural Resource Management (NRM) 

▪ Land Use/Land Cover (LULC) Mapping: Creating high-accuracy maps that classify 

every square meter of land to monitor compliance, track biodiversity loss, and inform 

conservation policies. 

▪ Precision Agriculture: Using satellite-derived spectral indices (NDVI) and 

prescription maps to vary the application of fertilizer, water, or pesticides within a field, 

maximizing yield while minimizing resource waste. 
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Disaster and Risk Management 

▪ Vulnerability Assessment: Creating complex maps by overlaying hazard layers (e.g., 

flood zones, seismic risk) with layers of social and physical assets (e.g., population 

density, roads, hospitals) to identify areas most at risk. 

▪ Rapid Damage Assessment: Automatically comparing pre- and post-disaster high-

resolution imagery to generate quick estimates of infrastructure damage for resource 

allocation. 

Urban and Infrastructure Management 

▪ Asset Management: Mapping all public assets (e.g., roads, streetlights, utility lines) 

with their exact location and condition, allowing for predictive maintenance scheduling 

and efficient budget allocation. 

▪ Urban Sprawl Monitoring: Quantifying the rate and direction of urban expansion using 

time-series LULC analysis to ensure planning accommodates sustainable growth. 

Visualization and Communication (M&E Reporting) 

The final, critical step: translating complex analysis into clear, actionable information for 

stakeholders. 

▪ GIS Dashboards: Creating dynamic, interactive web-based interfaces that link key 

M&E data (KPIs, graphs) directly to a map. This allows decision-makers to view real-

time project status and filter data spatially (e.g., instantly see all project sites with 

budget overruns in a specific region). 

▪ Map-Based Storytelling: Utilizing web-GIS platforms to combine engaging 

cartography, narrative text, and multimedia elements into compelling visual reports that 

communicate project impact and evaluation results effectively to non-technical 

audiences. 
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▪ Transparency and Accountability: GIS provides an objective, verifiable, and location-

specific record of all activities, from asset placement to intervention boundaries, which 

significantly enhances donor and stakeholder trust. 

 

 

Next Steps for Training 

The concepts covered are best solidified through practical application. A beneficial next step 

would be to focus on a Case Study (e.g., monitoring a large-scale agricultural infrastructure 

project or an environmental conservation effort) to apply these advanced concepts practically 

using real-world data and tools. 

Which is in our next lecture (Case Study).  

CASE STUDY-BACKGROUND 

This is a detailed case study demonstrating the practical application of advanced GIS and 

Remote Sensing concepts (as outlined in the training manual) for monitoring and managing a 

large-scale agricultural initiative. 

Case Study: Monitoring the "Green Belt Initiative" (GBI) 

Project Goal: To increase national food security by establishing 50,000 hectares of high-yield 

irrigated farmlands across four regional districts over a five-year period, focusing on 

sustainable water and fertilizer use. 

Challenge: The project requires real-time monitoring of crop health, early detection of 

pest/disease outbreaks, optimization of variable rate irrigation (VRI), and accurate calculation 

of yield impact for M&E reporting. 

 

CASE STUDY 

Data Acquisition and Advanced Sources 

The M&E framework for the GBI relies on a layered approach to data collection, ensuring both 

broad coverage and high local detail. 

Advanced Remote Sensing Platforms 

▪ Sentinel-2 Imagery (Temporal and Spectral): 

o Purpose: Provides free, high-frequency (5-day revisit) imagery to monitor the 

entire 50,000-hectare area weekly. 

o Data Used: Multispectral bands are used to calculate spectral indices like NDVI 

(crop health) and NDWI (water stress) over the entire project area. 

▪ UAV/Drone Imagery (Spatial Resolution): 

o Purpose: Used selectively by field teams for ground-truthing and rapid 

assessment of high-risk areas identified by satellite data (e.g., a field showing 

sudden NDVI decline). 
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o Data Used: Ultra-high resolution (sub-5 cm) RGB and near-infrared imagery to 

identify specific weed types or insect damage spots. 

▪ LiDAR/SAR Data (3D and Non-Optical): 

o Purpose: SAR (Radar) is used every two weeks, regardless of cloud cover, to 

monitor soil moisture levels in flood-prone sections. LiDAR data is used once 

at the baseline for accurate Digital Elevation Models (DEMs) for irrigation 

planning. 

 

 

In-Situ & Mobile Data Collection 

▪ Mobile GIS Applications (KoboToolbox/Survey123): 

o Purpose: Field officers use mobile devices for real-time data collection. 

o Data Collected: Accurate GNSS-georeferenced data on pest sightings, soil 

sampling locations, irrigation system maintenance issues, and farmer 

interviews, all linked directly to the spatial database 

Big Data & Cloud Processing 

▪ Google Earth Engine (GEE): 

o Purpose: Used for baseline analysis and historical context. 

o Process: GEE processes 20 years of historical Landsat data to establish the 

baseline land cover/land use (LULC), historical drought indices, and maximum 

potential crop yields for the four districts. This baseline is crucial for 

attributional M&E. 

 

Advanced Spatial Analysis for M&E 

The collected data is moved beyond simple mapping into powerful analytical models to 

generate actionable insights. 

Change Detection and Trend Analysis 

▪ Time Series NDVI Analysis: 

o Process: Weekly Sentinel-2 NDVI values are plotted over the entire growing 

season for every agricultural parcel. 

o Result: The system automatically flags any field where the NDVI value drops 

below the historical average growth curve for more than two consecutive weeks, 

indicating a significant, persistent stress (water shortage, nutrient deficiency, or 

disease). 

 

▪ Change Detection for LULC (Pre- and Post-Intervention): 

o Process: Comparing the GEE historical LULC map (baseline) with the current 

year's end-of-season map to quantify the net increase in actively cultivated and 

irrigated land, directly measuring the project's reach and impact. 
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Geostatistical Analysis 

▪ Kriging for Soil Quality Mapping: 

o Process: Sparse soil samples collected via Mobile GIS (measuring Nitrogen, 

Phosphorus, Potassium - NPK) are used in a Kriging interpolation model to 

create a continuous, smooth surface map of NPK deficiency across the entire 

project area. 

o Result: This continuous surface is used to divide fields into different 

management zones based on nutrient levels. 

▪ Hotspot Analysis (Getis-Ord Gi): 

o Process: Real-time field observations of pest infestations (collected via Mobile 

GIS) are analyzed using Hotspot Analysis. 

o Result: Identifies statistically significant spatial clusters (hotspots) of 

infestation, confirming the outbreaks are not random and guiding targeted pest 

control teams. 

 

Resource Management Applications (NRM & Infrastructure) 

The analytical output directly informs critical resource allocation decisions. 

 

Precision Agriculture 

▪ Variable Rate Fertilization (VRF): 

o Application: The NPK deficiency map generated by Kriging (Section 2B) is 

used to create prescription maps. 

o Action: These maps are uploaded to VRF-capable farm equipment, ensuring 

only the deficient zones receive specific amounts of fertilizer, preventing 

overuse, pollution, and saving costs. 

▪ Precision Irrigation: 

o Application: NDWI (from Sentinel data) and SAR-derived soil moisture levels 

identify fields under water stress. 

o Action: The system generates weekly recommendations for farmers, prioritizing 

water distribution to the areas of highest need, maximizing water use efficiency 

across the 50,000 hectares. 

 

Optimal Resource Placement 

▪ Service Accessibility Analysis (Network Analysis): 

o Process: Uses road networks and farm locations to calculate the travel time 

from each farm to the nearest GBI technical support office and the nearest major 

market. 

o Action: If analysis shows large clusters of farms are over 60 minutes from a 

support office (low accessibility), it justifies the need to locate a new satellite 

office or resource depot in that location to ensure equitable service delivery.  
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Visualization and Communication (M&E Reporting) 

The final, actionable step is translating complex geospatial data into simple, dynamic 

communication tools. 

 

GIS Dashboard (Real-Time Monitoring) 

▪ Structure: A dynamic web dashboard is created for project managers and donors. 

▪ Components: 

o Map Window: Shows the status of all 50,000 hectares. Fields are color-coded 

based on their NDVI status (Green: Healthy, Yellow: Stress, Red: Critical). 

o KPI Panel: Displays aggregate metrics (e.g., Percentage of fields below average 

NDVI, Total hectares requiring irrigation, Days since last major pest hotspot). 

o Interactive Filters: Allows users to filter data by district, crop type, or 

intervention stage. 

o Goal: Provides a single, real-time picture of project performance and allows 

drill-down investigation into specific fields. 

 

Map-Based Storytelling (M&E Impact Reporting) 

▪ Format: An interactive web Story Map is generated for the final donor report. 

▪ Content: 

o Baseline Slide: Shows the GEE historical LULC map, highlighting the initial 

barren/low-yield area. 

o Intervention Slide: Overlays the location of new irrigation infrastructure 

(mapped by field teams) and the areas targeted by VRF. 

o Impact Slide: Presents the Change Detection results (Section 2A), showing the 

final measured increase in irrigated land and comparing actual yield to the 

historical GEE-derived potential yield, clearly articulating the project's success 

and attribution. 

 

Transparency and Accountability 

▪ Geospatial Audit Trail: The M&E system maintains a verifiable, location-specific 

record of every critical activity (e.g., the coordinates of every new irrigation pump, the 

date of every fertilizer application based on the prescription map, and the exact 

boundaries of every farm). This objective record enhances accountability to 

stakeholders.  
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Basic Concepts of GIS Technology 

Abid Kamal 

GIS Analyst, Crop Zoning Project  

Bangladesh Agricultural Research Council 

Email: geoabid38@gmail.com 
 

1. Equator and Prime Meridian 

The Equator is an imaginary line that circles the Earth horizontally at its widest point. It lies 

midway between the North Pole and the South Pole and divides the planet into the Northern 

Hemisphere and Southern Hemisphere. It is assigned the value 0° latitude, serving as the 

starting point for measuring distances north or south. 

 

The Prime Meridian is another imaginary line that runs vertically from the North Pole to the 

South Pole. It passes through Greenwich, London, and divides the Earth into the Eastern 

Hemisphere and Western Hemisphere. It is defined as 0° longitude. The Prime Meridian 

helps create a global reference grid when combined with the Equator. 

Together, these two lines form the foundation for the Earth’s geographic coordinate system, 

allowing every location to be described using numerical values. 

2. Latitude and Longitude 

The Earth’s surface is divided using a network of lines known as latitude and longitude. 

 

 

mailto:geoabid38@gmail.com
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Latitude 

• Lines of latitude, also called parallels, run east–west. 

• They measure how far north or south a point is from the Equator. 

• Latitude values range from 0° at the Equator to 90° at the poles. 

• Positive values indicate the Northern Hemisphere, and negative values indicate the 

Southern Hemisphere. 

 

Longitude 

• Lines of longitude, called meridians, run north–south. 

• They measure how far east or west a point is from the Prime Meridian. 

• Longitude values range from 0° to 180° east and 0° to 180° west. 

Together, latitude and longitude allow us to identify any location on Earth using a pair of 

coordinates (for example, 23.8103° N, 90.4125° E for Dhaka). 

3. Geographic Coordinate System (GCS) 

A Geographic Coordinate System represents locations on the Earth’s spherical surface. 

Instead of a flat map, GCS uses a 3D ellipsoid or spheroid to approximate Earth’s shape. 

A GCS consists of: 

1. An ellipsoid – a mathematical model of Earth’s shape. 

2. A datum – the connection between the ellipsoid and real-world locations. 

3. Units of measurement – usually degrees of latitude and longitude. 

Because it is based on a curved surface, GCS is ideal for storing global data. However, GCS 

is not suitable for accurate distance, area, or direction measurements on flat maps—

these require projected coordinate systems. 
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4. What is GIS? 

A Geographic Information System (GIS) is a technology that integrates maps, data, and 

analysis tools to understand spatial patterns and relationships. 

GIS can: 

• Collect and store location-based data 

• Analyze spatial relationships (e.g., distance, patterns, clustering) 

• Produce maps and visualizations 

• Support decision-making in fields like environment, urban planning, agriculture, 

disaster management, and public health 

GIS connects “where something is” with “what something is,” making it a powerful tool for 

solving real-world geographic problems. 

 

5. GIS Data Types 

 

a. Vector Data 

Vector data uses geometric shapes to represent real-world features: 

• Points for single locations (e.g., tube wells, schools) 

• Lines for linear features (e.g., roads, rivers, pipelines) 

• Polygons for areas (e.g., districts, agricultural fields, lakes) 

Vector data provides: 

• High precision 

• Clean boundaries 

• Easy attribute management 

It is ideal for mapping administrative boundaries, infrastructure, and land parcels. 
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b. Raster Data 

Raster data represents the Earth’s surface through a grid of cells or pixels. Each pixel holds a 

value, such as: 

• Reflectance values in satellite imagery 

• Elevation (from DEMs) 

• Soil moisture 

• Temperature or rainfall values 

Raster data is best for: 

• Continuous phenomena 

• Environmental monitoring 

• Remote sensing analysis 

The detail depends on pixel size; smaller pixels mean higher resolution. 

 

6. Shapefile Format 

A Shapefile is one of the most commonly used vector data formats in GIS. It was developed 

by Esri and remains popular due to its simplicity and compatibility. 

A shapefile is not a single file—it is a collection of files with the same name but different 

extensions, including: 

• .shp – geometry of the features 

• .shx – index file 

• .dbf – attribute table (stores data in tabular form) 

• .prj – projection information (optional but important) 

 

Limitations: 

• Cannot store complex relationships 

• Maximum 10-character field names 

• No support for large datasets or advanced data types 

Despite these limits, shapefiles are ideal for quick sharing and simple analysis. 

 

7. Geodatabase 

A Geodatabase (GDB) is a modern method for storing and managing large volumes of GIS 

data in a structured environment. 
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Two common types: 

1. File Geodatabase (.gdb) – stored as a folder on your computer 

2. Enterprise Geodatabase – stored in a database server and supports multiple users 

Advantages: 

• Efficient storage of large spatial datasets 

• Support for topological rules 

• Can store multiple feature classes, raster datasets, tables, and relationships 

• Faster performance than shapefiles 

Geodatabases are recommended for large projects, organizations, and long-term data 

management. 

 

8. Map Scale 

Map scale indicates the relationship between a distance on the map and the corresponding 

distance on the ground. 

Examples: 

• 1:5,000 – 1 cm on the map = 50 m on the ground 

• 1:50,000 – 1 cm = 500 m 

• 1:1,000,000 – 1 cm = 10 km 

Types of scale: 

• Large-scale maps show small areas in great detail (e.g., ward or village maps). 

• Small-scale maps show large areas with less detail (e.g., national maps). 

Scale influences accuracy, symbolization, and the visual appearance of spatial features. 

9. GIS Software 

Various software tools support GIS tasks. Popular examples include: 

QGIS 

• Free and open-source 

• Widely used worldwide 

• Strong community support 

• Suitable for beginners and professionals 

ArcGIS 

• Commercial software by Esri 

• Advanced analysis capabilities 

• Ideal for organizational and enterprise settings 
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Other Tools 

• GRASS GIS – advanced open-source analysis 

• GeoServer – for publishing spatial data on the web 

• Google Earth Engine – cloud-based remote sensing and analysis 

• MapInfo, ERDAS Imagine, ENVI – specialized for image analysis 

Each software offers unique tools for mapping, editing, analysis, and visualization. 

 

10. Map Projection and Coordinate System 

A map projection is a mathematical method of converting the Earth’s curved surface (3D) 

into a flat map (2D). Since the Earth is round, all projections introduce some form of 

distortion (area, shape, distance, or direction). 

Different projections preserve different properties: 

• Equal-area projections – preserve area 

• Conformal projections – preserve shape 

• Equidistant projections – preserve distance 

• Azimuthal projections – preserve direction 

A Projected Coordinate System (PCS) combines: 

• A map projection 

• Linear units (meters or feet) 

• A coordinate grid (e.g., UTM) 

PCS is essential for accurate measurement and spatial analysis on flat maps. 
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11. Datum 

A Datum defines the position of the ellipsoid relative to the Earth’s surface. It provides the 

base reference for measuring geographic coordinates. 

Two key components: 

1. Ellipsoid – mathematical shape approximating Earth 

2. Anchor point(s) – physical locations where the ellipsoid is aligned with Earth 

Examples: 

• WGS 84 – used by GPS and global datasets 

• NAD 83 – used in North America 

• BTM Gulshan 303 – used for national mapping in Bangladesh 

Different datums can produce coordinate differences of several meters to hundreds of meters. 
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Geo-referencing Techniques, Create and Edit 

Shapefiles 
K. H. Razimul Karim 

Senior Specialist, CEGIS 

Email: razimulseye@gmail.com  
 

Start ArcMap and open map document 

➢ From the Windows taskbar, click Start > All programs > 

ArcGIS > ArcMap to open the ArcMap.  Depending on 

which Windows operating system is in use, there may be a 

bit of difference in navigation to open ArcMap. 

➢ If you have shortcut icon  on your desktop or pinned in 

taskbar, double-click on it to start ArcMap. 

➢ In the resulting ArcMap window, click Existing Maps > 

Browse for more.  

➢ Browse to the drive on which the tutorial data has been 

stored (e.g. D:\ArcGIS Training\Training 

Data\Exercise MXD) and click Ex_05.mxd > Open. This 

opens the list of layers in Table of Contents in the left side 

and their graphical display in the right side of ArcMap 

application window.  

Georeferencing Image data 

The purpose of georeferencing is to make satellite, aerial as well as terrestrial imageries useful 

for GIS mapping and the process adds geographic information to the image so that GIS can 

place the image in its appropriate real world’s location. Given that a scanned enumeration area 

(EA) map is stored as image format. Now we are going to add coordinates to this image to 

place just like it is in real world’s location. 

➢ Tick the EA_Map_Goakandia_original.jpg stored in ToC and explore the image, 

especially the coordinates in image border. These coordinates are showing the real 

world location but do not exactly represent the place in ArcMap as it is not 

georeferenced. Now we will add the real world coordinates to this image in ArcMap to 

represent the exact location as it appears in real world. If you notice the coordinates 

carefully, you would see that the interval is 30 seconds among the labelled coordinates. 

➢ Now open the EA_coordinates.csv in Excel from working folder. Four coordinate 

values from EA_Map_Goakandia_original.jpg image have been selected for this 

exercise, stored in excel in separate column and converted from 

Degree/Minute/Second to Degree format by using simple formula of Degree+ 

minutes/60 + Seconds/3600. 

➢ Now check the EA_Map_Goakandia.jpg stored in ToC which has four parallel 

connecting lines of latitude 2505’30’’ and 2503’30’’ and longitude 90037’30’’ and 

mailto:razimulseye@gmail.com
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90039’30’’.  The four lines meet at four cross points of which coordinate values are 

considered for this exercise. 

➢ Observe the selected coordinates in the image border carefully. You would realize that 

the selected four coordinates are taken from four different corners of the image  

Note that when we are georeferencing an image adding its coordinate data, we need to consider 

the latitude and longitude values distributed more or less equally throughout the map. We need 

to consider coordinates in four sides of the image for balanced georeferencing and avoiding 

errors. 

➢ In ArcMap from menubar, click File> Add Data > 

 Add XY Data.  Window appears. 

➢ Browse EA_cordinates.csv table from working 

folder in Choose a table from the map or browse 

for another table. 

➢ In X Field select Converted_Longitude and in Y 

Field select Converted_Latitude. 

➢ Click Ok > OK in next window. Now the XY values 

are added to ToC as new point layer. 

➢ Change the symbol into Circle 3 from Symbol 

Selector window as we did earlier. 

➢ If we zoom into the points on map display, you 

would see four points which are in a similar position 

of the points found from connecting lines on 

EA_Map_Goakandia.jpg.  

 

 

 

 

 

 

➢ Now we need to develop connections between two points in similar position, e.g. the 

point symbol at the top left is in similar position of meeting point of latitude 2505’30’’  
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and longitude 90037’30’’ lines. We would connect them together since they are 

respective points. 

➢ From menu bar click on Customize > Customize Mode. Customize window appears. 

Check Georeferencing from the list of Toolbars and click Close. The Georeferencing 

tool appears on the toolbar in ArcMap. This tool is used to georeference raster and 

CAD data. 

 

➢ Turn on Auto Adjust in the Georeferencing pulldown or dropdown list 

. 

➢ Set EA_Map_Goakandia.jpg as the target layer in the georeferencing toolbar since it 

has the cross points for the coordinate values. 

➢ Choose Fit to Display from the georeferencing pulldown. 

➢ Using Zoom In tool  from Tools, zoom in to the cross point of latitude 2505’30’’  

and longitude 90037’30’’ on image unless the pixels are very clear. Target the center of 

the most middle pixel of the cross point. 

➢ Click on Add Control Points in Georeferencing tool from toolbar. 

➢ When the Add Control Points is active, click on the center of the most middle pixel of 

the zoomed cross point and then find the respective point (the top left one we have 

targeted) and click in the middle of the point symbol. Now the connected line appears 

between in the center of the cross point and the point symbol. At this stage, the first 

control point is added.  
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➢ Now, follow the same procedure for the remaining points. Remember that first click 

should be on image since we are georeferencing the image and then next click should 

be on respective point symbol to assign that coordinate value to the cross point. Also 

remember that this process should be done precisely. 

➢ When four control points are added to the image, the four point symbols appears right 

on the four cross points and image will be set at right place.  

➢ If you add a control point that is problematic, you can open View Link Table from 

Georeferencing tool and un-check it or use the delete control point tool to remove it. 

➢ Now that we have all four control points added, examine the link table. This table shows 

which of the added points fit best with the 1st order Polynomial (Affine) in 

Transformation at the bottom. 

➢ Un-check the points with the biggest errors (maximum0.05 at Residual) and notice 

how the fit of all of the other points improves. 

 

➢ From the Link table, save your control points as a text file in working folder as 

Control_points.txt by clicking on Save button  in table. This will allow user to 

pick up and refine this georeferencing project later. Close the table by clicking x tab in 

the top right corner of the table window. 

➢ Choose Update Georeferencing from the Georeferencing pulldown. 

➢ Open the working folder and notice that new JGWX and XML Document files have 

been created. 

➢ Check the Spatial Reference properties of EA_Map_Goakandia.jpg image. Note that 

it has inherited the Coordinate Reference Systems from the data frame. 

Finally, save the map document with all your work done in this exercise and exit ArcMap. 
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Feature Extraction from Satellite Images in ArcGIS 

 

Start ArcMap and open map document 

➢ From the Windows taskbar, click Start > All programs > 

ArcGIS > ArcMap to open the ArcMap.  Depending on 

which Windows operating system is in use, there may be a 

bit of difference in navigation to open ArcMap. 

➢ If you have shortcut icon  on your desktop or pinned in 

taskbar, double-click on it to start ArcMap. 

➢ In the resulting ArcMap window, click Existing Maps > 

Browse for more.  

➢ Browse to the drive on which the tutorial data has been 

stored (e.g. C:\ArcGIS Training\Training Data\Exercise 

MXD) and click Ex_12.mxd > Open. This opens the list of 

layers in Table of Contents in the left side and their 

graphical display in the right side of ArcMap application window.  

Creating shapefile/ Feature Class  

➢ Open and extend the working geodatabase in Catalog Tree window as explained in 

Exercise 07 

➢ Right-click Training_geodatabase.mdb and click New > Feature Class  

➢ New Feature Class window appears.  

➢ Type Rural_settlement for Nameand select Polygon features from the dropdown list 

of Type of features stored in this feature class  in Type. Click Next. 

➢ In next window, from Favorites select 

Gulshan_303_To_WGS_84_1_Transverse_Mercator and click Next > Next in next 

window> finally Finish. 

➢ New Feature Class/ Shapefile called Rural_Settlement is 

created in geodatabase and automatically added to ToC. 

➢ The alternative way to 

create a shapefile  is to 

extend the working folder 

in Catalog Tree window as 

explained in Exercise 07 

and right-click the folder  

and click New > Shapefile 

. Then follow the same 

procedure just explained 

above  

➢  Now create another 

shapefile called Building_footprint of Polygon features and same coordinate system. 
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Exploring Editor toolbar  

➢ Click the Editor Toolbar button  on the Standard toolbar to 

display the Editor Toolbar. 

➢ The dropdown list of Editor Menu has options to start editing 

session clicking on Start Editing, saving edits by clicking on 

Save Edits, stop editing mode by using Stop Editing. 

➢ Editor Toolbar appears with a package of tools to draw or edit 

new features. 

➢ Sketching tools help draw or digitize a feature. 

➢ Reshape, Split, Cut Polygon, Rotate, Edit Vertices- these tools 

help to edit or modify any feature drawn. 

➢ Create Features help to select the feature you want to edit and the Construction tool 

such as Polygons, Auto Complete Polygon, Rectangle, Circle etc.  required for new 

feature. 

➢ Edit tool helps select the feature that you want to edit and use other tools to start the 

operation. 

Settlement Extraction  

Now we are going to extract rural settlement and urban footprints from satellite images using 

Editor tool. Rural settlements will be drawn in Rural_Settlement.shp file and building 

footprints will be drawn in Building_footprint.shp. 

Rural settlement extraction 

➢ Browse working folder and drag and drop Rural_Area image into ToC.  

➢ Note that Rural Settlement layer should be on top of Rural_Area in the ToC to view 

the edits on satellite image. 

➢ Change the Red, Green, Blue band 

combination into band 4, 3,2 consecutively  

by clicking the colored rectangle symbol and 

selected desired band one by one to better 

visualization of vegetation since we are going 

to consider homestead vegetaions for rural 

settlement. In case of any confusion, Band 

combination is changed temporarily to 3,2,1to interpret settlements.  

➢  In Rural_Settlement layer, click on the symbol in rectange shape and select Hollow 

in Symbol Selector window. Change the Outline color into Yellow and Outline width 

into 1.5 to make the edits eye catchy. 

➢ In Editor Toolbar, click Start Editing to start the edit session. Start Editing window 

appears with the layers added to ToC. 
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➢ Select Rural_Settlement and click Ok > Continue in the next window if there is any 

. 

➢ Now Edit tool  is active as a mouse pointer on map display and is selected in 

toolbar. 

➢ Click on Create Features  button in Editor toolbar. A Create Features window 

appears. 

➢ Click on Rural_Settlement and below you should be getting the options in 

Construction Tools. Select Polygon over there. 

➢ Now the editing mode is active since the mouse pointer is changed into an addition sign 

+. 

➢ Use Zoom in  and Pan  in Tools from toolbar to find the desired area to start 

drawing feature and use the scale from 1:1200 to 1:1500. 

➢ Now follow the settlement boundary line and keep clicking until you get the shape of 

the boundary.  

➢ Double click to finish drawing polygons. The digitized polygon or feature remains 

selected on map display. The selection will be gone when it is saved or when the next 

feature will be drawn. 

➢ The first settlement is drawn already and a record is added to attribute table of 

Rural_Settlement layer which is on the fly. We need to save the edits. 

➢ To save the drawing features, click Save Edits in Editor menu. 

➢ If you don’t get the drawings perfectly, use Reshape, Split, Cut Polygon, Rotate, Edit 

Vertices tools in Editor Toolbar and save the edits. But make sure that before you use 

these tools, the feature that you want to edit or change the shape should remain selected.  

➢ When all the settlements are drawn and saved , click Stop Editing in Editor Menu. 

➢ Now the rural settlent is extracted in Rural_Settlement layer from given satellite 

image. Explore the attribute table to see the records and get out of it by clicking Close 

tab. 
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N.B: An example shapefile called Example_Rural is provided in the working geodatabase for 

your convenience to have a look and get idea on how to draw the shapes or the boundary lines. 

To view it, drag and drop the layer in ToC and change the symbol color into Hollow for better 

visualization. This example layer has the rural features in some parts of Rural_Area image.  

Please continue digitizing settlements in Rural_Settlement layer for your practice.  

 

Building footprints extraction 

➢ Browse working folder and drag and drop Urban_Area image into ToC.  

➢ Note that Building_footprint layer should be on top of Urban_Area in the ToC to 

view the edits on satellite image. 

➢ Change the Red, Green, Blue band combination into band 4, 3,2 . In case of any 

confusion, Band combination is changed temporarily to 3,2,1to interpret settlements.  

➢  In Building_footprint layer, click on the symbol in rectange shape and select Hollow 

in Symbol Selector window. Change the Outline color into Yellow and Outline width 

into 1.5 to make the edits eye catchy. 

➢ In Editor Toolbar, click Start Editing to start the edit session. Start Editing window 

appears with the layers added to ToC. 

➢ Select Building_footprint and click Ok > Continue in the next window if there is any 

. 

➢ Now Edit tool  is active as a mouse pointer on map display and is selected in 

toolbar. 

➢ Click on Create Features  button in Editor toolbar. A Create Features window 

appears. 

➢ Click on Building_footprint and below you should be getting the options in 

Construction Tools. Select Polygon over there. 

➢ Now the editing mode is active since the mouse pointer is changed into an addition sign 

+. 

➢ Use Zoom in  and Pan  in Tools from toolbar to find the desired area to start 

drawing feature and use the scale from 1:1200 to 1:1500. 

➢ Now follow the edge of buildings and keep clicking until you get the shape of the 

building.  

➢ Double click to finish drawing polygons.  

➢ The first building is drawn already and a record is added to attribute table of 

Building_footprint layer which is on the fly.  

➢ To save the drawing features, click Save Edits in Editor menu. 

➢ If you don’t get the drawings perfectly, explore use Reshape, Split, Cut Polygon, 

Rotate, Edit Vertices tools in Editor Toolbar and save the edits. 

➢ When all the settlements are drawn and saved , click Stop Editing in Editor Menu. 

➢ Now the rural settlent is extracted in Building_footprint layer from given satellite 

image. Explore the attribute table to see the records and get out of it by clicking Close 

tab. 
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N.B: An example shapefile called Example_Urban is provided in the working geodatabase 

for your convenience to have a look and get idea on how to draw the shapes or the boundary 

lines. To view it, drag and drop the layer in ToC and change the symbol color into Hollow for 

better visualization. This example layer has the rural features in some parts of Urban_Area 

image.  Please continue digitizing urban settlements in Building_footprint layer for your 

practice.   

 

Finally, save the map document with all your work done in this exercise and exit ArcMap. 

 

 

Create A New Shapefile 

 

You can create new shapefiles in ArcCatalog or by using the Create Feature Class tool. When 

you create a new shapefile, you must define the types of features it will contain, whether those 

features will represent routes (m-values), and whether those features will be three-dimensional 

(z-values). These properties can't be modified after the shapefile has been created. You can also 

define the coordinate system of the shapefile. If you choose to define the shapefile coordinate 

system later, it will be classified as Unknown until then. The process of defining the new 

shapefile's attributes is separate from creating the shapefile itself. After creating the item, define 

its attributes by right-clicking it in ArcCatalog and clicking Properties. Because it must contain 

at least one attribute column. ArcCatalog adds a default column to the shapefile when it is 

created. For shapefiles, an integer column named Id is added as an attribute. Add the 

appropriate attributes to your shapefile. After the new attributes have been added as part of the 

shapefile, you can delete the default column if you decide you don't want to use it.  
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1. Select a folder or folder connection in the 

Catalog tree.  

2. Click the File menu, point to New, then 

click Shapefile.  

3. Click in the Name text box and type a 

name for the new shapefile.  

4. Click the Feature Type drop-down arrow 

and click the type of geometry the 

shapefile will contain.  

5. Click Edit to define the shapefile's 

coordinate system.  

6. Select, import, or define a new coordinate 

system.  

7. It's highly recommended that you define 

the shapefile's coordinate system now; however, you can postpone this step until a later 

time. For more information, see Fundamentals of a shapefile's coordinate system and 

Click OK.  

8. If the shapefile will store polylines representing routes, check Coordinates will contain M 

values.  

9. If the shapefile will store three-dimensional features, check Coordinates will contain Z 

values and Click OK. 

 

The new shapefile appears in the folder's contents. 

Editing Features in a Shapefile 

Digitizing, the process of converting features into a digital format, is one way to create data. 

There are several ways to digitize new features. These include digitizing on-screen or heads up 

over an image, digitizing a hard copy of a map on a digitizing board, or using automated 

digitization. 

Interactive, or heads-up digitization, is one of the most common methods. In this method, you 

display an aerial photograph, satellite image, or orthophotograph on-screen as a basemap, then 

you draw features, such as roads, buildings, or parcels, on top of it. 

In hard-copy digitizing, you use a digitizing table connected to a computer that converts 

positions on the table surface into digital x,y coordinates as you trace them with a handheld 

puck (a pen or mouse like device). 
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Automatic digitization is another method of digitizing features. The ArcScan for ArcGIS 

extension enables you to perform automatic or interactive raster-to-vector data conversion with 

high precision and little or no operator intervention during the data capture stage.  

 

Starting an Edit Session 

Editing occurs in an edit session. During an edit session, you can create or modify vector 

features or tabular attribute information. When you want to edit, you need to start an edit 

session, which you end when you're done. Editing applies to a single workspace in a single 

ArcMap data frame, where a workspace is a geodatabase or a folder of shapefiles. If you have 

more than one data frame in your map, you can only edit the layers in one data frame-even if 

all data is in the same workspace. Although you can edit data in different coordinate systems, 

it is generally best if all the data you plan to edit together has the same coordinate system as 

the data frame. 

 

 

 

 

 

 

Figure: Sketching a new polygon feature 
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Creating Features with Feature Templates 

Creating features is accomplished 

through the use of feature templates. 

Feature templates define all the 

information required to create a 

feature: the layer where a feature will 

be stored, the attributes a feature is 

created with, and the default tool used to 

create that feature. Templates also have 

a name, description, and tags that help 

you to find and organize them. If 

templates are not present when you start 

editing, they are automatically created 

for each layer in the current editing 

workspace. Templates are saved in map 

document (.mxd) and layer file (.lyr).  

 

A layer can have multiple templates associated with it, where each template has different 

default settings. For example, if you have a roads layer with classifications of freeway, major 

highway, and local road, you could have three different templates with each one having a 

different default attribute for the type of road. This makes it easier for you to create the new 

type of road you want from the start. To create a local road feature, simply click the local road 

template and new features are automatically created as a local road and attributed and 

symbolized properly. You still need to add other, nondefault attribute values after you create 

the feature. 

Using Snapping while Editing 

Snapping allows you to create features that connect to 

each other so that your edits are more accurate and have 

fewer errors. With snapping, your pointer will jump, or 

snap to, edges, vertices, and other geometric elements 

when it nears them. This enables you to position a 

feature easily in relation to the locations of other 

features. As you move your pointer around the map, it 

snaps automatically to points, endpoints, vertices, and 

edges. All the settings you need to work with snapping 

are located on the Snapping toolbar, including enabling 

and disabling snapping types and setting snapping 

options. The main snap types are buttons on the toolbar, 

but additional ones are available on the Snapping 

menu. 

 

Figure: Create new templates wizard 

Figure: Snapping tools 

 



31 | P a g e   

Creating Points 

Points are the simplest features to create. Simply click a point template in the Create Features 

window and the Point tool is automatically activated. Click the map where you want to add the 

point. You can right-click the map or use snapping to help you create points at exact locations. 

Creating Lines and Polygons (Segments) 

To create segments in lines or polygons, you will most commonly use the Line tool (with line 

templates) and the Polygon tool (with polygon templates). While these tools are used with 

different template types, they behave similarly. To create segments, simply click the map where 

you want to place vertices. 

 

 

Creating Text Features 

You can store map text as annotation in a geodatabase. Annotation provides flexibility in the 

appearance and placement of your text because you can 

select individual pieces of text and edit them. Dimension 

features are a form of annotation designed to express 

distance measurements. Like other types of features, 

geodatabase annotation and dimension features are 

created inside an edit session, using feature templates 

and the tools on the Create Features window. Some 

annotation feature classes, such as standard annotation, 

stand alone in the geodatabase. Standard annotation is 

Figure: Creation of points, line polygon 
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not formally associated with features in the geodatabase. For example, you might have a piece 

of standard annotation that represents a mountain range, an ocean, or an administrative 

boundary-the annotation simply marks the general area on the map. 

Another kind of annotation, feature-linked annotation, is associated with the feature it is 

describing through a relationship class. The text reflects the value of a field or fields from the 

feature to which it is linked. You might use feature-linked annotation to identify features such 

as parcels, streets, rivers, roads, or cities. With feature-linked annotation, as you create parcels 

or street features, for example, using the editing tools in ArcMap, annotation is created 

automatically. 

 

Defining New Types of Features to Create 

Sometimes, you may want to create features of a certain type in an existing layer, but the layer 

is not set up to capture those features. For example, you want to add features to a roads layer 

to represent an unpaved road, but you currently only have categories in your data for freeway, 

major highway, and local road. Through a 

wizard, you can define everything about the 

unpaved road category at one time—making 

it easy to prepare your data to display and 

store the new types of features. ArcMap 

automatically adds a symbol for the new 

category, any required geodatabase 

information (such as subtype value or coded 

domain value) for that layer, and a feature 

template to use when creating an unpaved 

road. The wizard saves you from having to 

stop your work to open multiple dialog   

      boxes to set up the data on your own. 

Editing existing features 

Once you have created features, you can also edit their shapes with the 

tools on the Editor Toolbar. For example, to split a polygon into two 

polygons, select the feature, click the Cut Polygons tool on the Editor 

Toolbar, then draw a line where you want to split the feature. To draw 

in a new shape for a line or polygon, select it, click the Reshape Feature 

tool on the Editor Toolbar, and sketch in how you want the feature to 

appear. 

 

Advanced Editing 

To use additional or more specialized editing tools, you must add other editing toolbars to 

ArcMap. These include Advanced Editing. 

 

Figure: Define new feature type wizard 
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Overview of ArcGIS 

Al-Helal 

Programmer, Computer & GIS Unit 

Bangladesh Agricultural Research Council 

Email: al.helal@barc.gov.bd 
 

 

The ArcCatalog application provides a Catalog window that is used to organize and manage 

various types of geographic information for ArcGIS Desktop. 

 

Items in the Catalog Tree View 

Folder Connections-Connections to file folders containing datasets and ArcGIS documents. 

Toolboxes- Geo-processing tools and scripts used in ArcGIS. 

Database Servers-SQL Server Express instances configured to store desktop or workgroup 

geodatabases. 

Database Connections-Connections 

to databases and enterprise 

geodatabases. 

GIS Servers-Connections to ArcGIS 

Server and OGC server sites. 

My Hosted Services-When you 

connect to and sign in to a portal, 

you can access the web layers and web maps you own or that have been shared with you. 

Ready-To-Use-Services-When you connect to ArcGIS Online, you can access a set of publicly 

available worldwide services. 

ArcMap represents geographic information as a collection of layers and other elements in a 

map. ArcMap is where you display and explore GIS datasets for your study area, where you 

assign symbols, and where you create map layouts for printing or publication. ArcMap is also 

the application you use to create and edit datasets. 

ArcMap is one of the primary desktop GIS applications included in the ArcGIS Desktop suite. 

It is used to perform a wide range of common GIS tasks as well as specialized, user-specific 

tasks. Here is a list of some common workflows you can perform: 

• Work with maps 

• Print maps 

• Compile and edit GIS datasets 

• Use geo-processing to automate work and perform analysis 

• Organize and manage your geodatabases and ArcGIS documents 

• Publish map documents as map services 

mailto:al.helal@barc.gov.bd
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• Share maps, layers, geo-processing models, and geodatabases with other users 

• Document your geographic information 

• Customize the user experience 
 
 

 

When you save a map, you have created in ArcMap, it will be saved as a file on disk. This is 

an ArcMap document and is referred to as a map document or mxd since the file name extension 

(.mxd) is automatically appended to your map document name. You can work with an existing 

.mxd file by double-clicking the document to open it. This will start an ArcMap session for that 

.mxd file. 
 

Map documents contain display properties of the geographic information that you work with 

in the map—such as the properties and definitions of your map layers, data frames, and the 

map layout for printing—plus any optional customizations and macros that you add to your 

map. 

ArcMap represents geographic information as a collection of layers and other elements in a 

map view. There are two primary map views in ArcMap: the data view and the layout view. 

In ArcMap data view, the map is the data frame. The active data frame is presented as a 

geographic window in which map layers are displayed and used. Within a data frame, you work 

with GIS information presented through map layers using geographic (real-world) coordinates. 

These will typically be ground measurements in units such as feet, meters, or measures of 

latitude-longitude (such as decimal degrees). The data view hides all the map elements on the 

layout, such as titles, north arrows, and scale bars, and lets you focus on the data in a single 

data frame, for instance, editing or analysis. 
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When you're preparing your map's layout, you'll want to work with your map in page layout 

view. A page layout is a collection of map elements (such as a data frame, map title, scale bar, 

north arrow, and a symbol legend) arranged on a page. Layouts are used for composing maps 

for printing or export to formats such as PDF. 

The Layout view is used to design and author a map for printing, exporting, or publishing. You 

can manage map elements within the page space (typically, in inches or centimeters), add new 

map elements, and preview what your map will look like before exporting or printing it.  
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Common map elements include data frames with map layers, scale bars, north arrows, symbol 

legends, map titles, text, and other graphic elements. 

Within the data frame, you display geographic datasets as layers, where each layer represents 

a particular dataset overlaid in the map. Map layers help convey information through: 

• Discrete feature classes such as collections of points, lines, and polygons. 

• Continuous surfaces, such as elevation, which can be represented in a number of ways. For 

example, as a collection of contour lines and elevation points or as shaded relief. 

• Aerial photography or satellite imagery that covers the map extent 

Example map layers include streams and lakes, terrain, roads, political boundaries, parcels, 

building footprints, utility lines, and orthophoto imagery 

In addition to representing geographic information, each layer's map symbols, colors, and 

labels help describe the objects in the map. You can interact with the layers displayed in each 

data frame to query each feature and see its attributes, perform analytical operations, and to 

edit and add new features to each dataset. 

 

 
 

A layer doesn't store the actual geographic data. Instead, it references a dataset, such as a feature 

class, an image, a raster, and so on. Referencing data in this way allows the layers on a map to 

automatically reflect the most up-to-date information in your GIS database. 

In ArcMap, you specify properties for each map layer, such as its map symbols and labeling 

rules, by right-clicking the layer in the table of contents and clicking Properties or by double- 

clicking on the layer name. 
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The Table of Contents window lists all the layers on the map and shows what the features in 

each layer represent. The check box next to each layer indicates whether its display is currently 

turned on or off. The order of layers within the Table of Contents window specifies their 

drawing order in the data frame. 

The map's table of contents helps you manage the display order of map layers and symbol 

assignment, as well as to set the display and other properties of each map layer. 

A typical map might have an image or a terrain base (such as shaded relief or elevation 

contours) near the bottom. Above that layer are a basemap; polygon, line, and point features; 

and annotation and other reference information. 
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The Standard toolbar most typically appears at the top of the ArcMap application window 

and is used for map printing, creating a new map, opening an existing map, saving your map, 

starting related ArcGIS applications, and more. 

 

Clicking ‘Add Data’ Button Opens the 

‘Add Data’ Dialog box for adding data of 

all compatible types to ArcMap. 
 

• Double-click to open items that house 

other items, such as a                       folder or feature 

dataset.  

• You will know what items are data and 

what items are “containers” for other 

data based upon the icon 

• Review File Icons 

• Control+Click or Shift+Click to select multiple items. 

 

“Add Basemap” option opens the dialog box to add one of many basemaps available from 

ArcGIS Online. 

• These maps are streaming over the        
Internet; thus, the speed of drawing will 

be based upon your internet speed. 

• These basemaps are in WGS 84 Web 

Mercator, and unless your project is in 

the same projection, take care when 

digitizing and georeferencing data to 

streaming basemaps. You may be 

affecting you overall                                                     accuracy and 

precision. 
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Working with Attribute Table 

Hasan Mahmud, Senior System Analyst, Computer & GIS Unit  

Bangladesh Agricultural Research Council 

Email: hasan.mahmud@barc.gov.bd 

 

Editing Attributes 

Attributes are descriptions of a geographic feature in a GIS, usually stored as a row in a table. 

For example, attributes of a river might include its name, length, and average depth. You can 

enter new attribute values when you create features, and you can edit existing values. When 

you create a feature, it starts with only the default attribute values as specified in the template 

used to create the feature. You input attributes after you create a feature. There are two main 

ways of adding or updating attributes in ArcMap: the Attributes window and the table window. 

 

Figure: Attribute table 
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Editing values in the table window 

Once you begin an edit session, you'll notice a pencil icon next to the Table Options button 

Table Options on the Table window, indicating that the table can be edited. In addition, those 

fields that you can edit will have a white background in the field heading. You can make any 

of the attribute changes you need by clicking a cell and typing a new attribute value. 

 

Figure: Editing Attribute table 
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Data Queries in GIS 

Al-Helal 

Programmer, Computer & GIS Unit 

Bangladesh Agricultural Research Council 

Email: al.helal@barc.gov.bd 
 

In GIS, Data Queries help you select, filter, and analyze records based on attribute 

information. ArcMap uses a Structured Query Language (SQL)-like syntax for queries. 

Basic Query Logic 

Logical 

Operator 

Meaning Example Purpose 

AND Both conditions 

must be true 

District = 'Dhaka' AND 

Population > 500000 
Find areas in Dhaka 

with population > 

500,000 

OR Either condition 

can be true 

District = 'Dhaka' OR 

District = 'Chittagong' 
Select features in either 

Dhaka or Chittagong 

LIKE Pattern matching 

(wildcards) 

District LIKE 'D%' Select districts starting 

with 'D' 

NOT Exclude specific 

values 

NOT District = 

'Barisal' 
Select everything 

except Barisal 

IS NULL Field has no data Population IS NULL Find features with 

missing population data 
 

 

How to Perform a Query in ArcMap 

1. Open Attribute Table 

❖ Right-click the layer > Open 

Attribute Table. 

2. Select by Attributes 

❖ Click Table Options (top left) > 

Select by Attributes. 

3. Build Your Query 

❖ Double-click a field, select an 

operator, and type your value. 

❖ Example: 
City = 'Dhaka' AND 

Population > 1000000 
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4. Apply the Query 

❖ Click Apply or OK to see selected features highlighted. 
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Data Joining: Spatial Join and Attribute Join 

Al-Helal 

Programmer, Computer & GIS Unit 

Bangladesh Agricultural Research Council 

Email: al.helal@barc.gov.bd 

 

ArcMap provides two primary methods for joining data: Attribute Join and Spatial Join. 

1. Attribute Join 

Purpose: Combine a table of data with spatial features based on a common attribute. 

Example Scenario: Joining a CSV file containing soil chemical data to a shapefile of districts using 

the 'TW_ID' field. 

Steps: 

1. Right-click on the target layer (e.g., 

Districts) in the Table of Contents. 

2. Select Joins and Relates > Join. 

3. In the Join Data dialog:  

o Choose Join attributes from a 

table. 

o Select the field in the layer that 

matches the field in the table. 

o Browse and select the table to 

join. 

o Choose the matching field in the 

table. 

4. Click OK. The attributes from the table 

are now associated with the spatial 

features. 
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2. Spatial Join 

Purpose: Combine attributes from one layer to another based on their spatial relationship. 

 

 

 

 

 

 

 

 

 

Example Scenario: Assigning the number of tubewells within each union. 

 

Steps: 

1. Right-click on the target layer (e.g., Union, Upazilla, District). 

2. Choose Joins and Relates > Join. 

3. In the Join Data dialog: 

o Select Join data from another layer based on spatial location. 

o Choose the layer to join (e.g., Tubewell, Schools, Farmers). 

o Specify the spatial relationship (e.g., features that intersect). 

4. Click OK. A new layer is created with combined attributes. 
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Basic Geoprocessing Tools 

Abid Kamal 

GIS Analyst, Crop Zoning Project  

Bangladesh Agricultural Research Council 

Email: geoabid38@gmail.com 

Geoprocessing refers to a collection of operations used to manipulate, analyze, and manage 

spatial data in GIS. These operations take geographic data as input, apply a process or 

transformation, and generate new datasets as output. 

Geoprocessing is essential for: 

• Spatial analysis 

• Data extraction 

• Overlay and proximity operations 

• Data cleaning and preparation 

• Creating new datasets based on analysis needs 

Common concepts: 

• Input Data: Feature class, shapefile, raster. 

• Parameters: Buffer distance, clipping boundary, dissolve field, etc. 

• Output Data: New feature class/shapefile with modified geometry/attributes. 

• Coordinate Systems: Very important for distance-based operations (e.g., buffer). 

• Environment Settings: Extent, output coordinate system, snapping, XY tolerance. 

In ArcMap, geoprocessing tools are available through ArcToolbox, ModelBuilder, Python 

script, or the Geoprocessing menu. 

 

Clip 

Clip is an extraction tool used to cut out features from an input layer based on the boundary of 

a clip polygon. Only those features (or parts of features) lying inside the clip polygon will be 

included in the output. It preserves the attributes of the input layer. 
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Used for: 

• Extracting study area 

• Cutting national layers to district/Upazila level 

• Focusing analysis on a specific boundary 

Requirements: 

• Input Features: Point, line, or polygon 

• Clip Features: Must be polygon 

Steps: 

1. Open ArcMap and add both Input Layer and 

Clip Polygon Layer.  

2. Ensure both layers use the same coordinate 

system or projection. 

3. Open: ArcToolbox → Analysis Tools → Extract → Clip 

4. Set parameters: 

• Input Features: Choose the layer you want to extract 

• Clip Features: Choose the polygon boundary 

• Output Feature Class: Choose location + name 

 

5.   Click OK. 

6.   Review the output layer. Check geometry and attribute table. 

 

Buffer 

Buffer is a proximity analysis tool that creates a zone around input features at a specified 

distance. The result is always a polygon, regardless of whether the input is point, line, or 

polygon. 
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Used for: 

• Identifying influence zones (e.g., 100 m around roads) 

• Creating safety zones 

• Environmental protection or planning 

Important: 

Always use a projected coordinate system (meters or feet). Degrees (Lat/Long) produce 

wrong distances. 

Steps:  

1.   Add the input layer (point/line/polygon). 

2.   Reproject to a projected CRS if needed. 

3.   Open: ArcToolbox → Analysis Tools → Proximity → Buffer 

4.   Set parameters: 

• Input Features: Select input layer 

• Output Feature Class: Provide location + 

name  

• Distance: e.g., 100 Meters, 500 Meters, 0.5 

Kilometers  

• Side Type (for lines): Full, Left, Right 

• End Type (for lines): Round or Flat 

• Dissolve Type: 

o NONE – individual buffers 

o ALL – merge overlapping buffers 

o LIST – dissolve using fields 

5.   Click OK. 

6.   Verify buffer distance using the Measure Tool. 
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Intersect  

Intersect combines multiple layers and returns only the areas where all input layers overlap. It 

keeps the attribute fields of all input layers, creating a detailed output table. 

Works with: 

• Points 

• Lines 

• Polygons 

Common usage: 

• Finding roads inside flood zones 

• Identifying agricultural land inside a project area 

• Extracting common areas from multiple thematic layers 

Steps: 

1. Load the input layers (two or more). 

2. Confirm they overlap spatially and have consistent 

CRS.  

3. Open: ArcToolbox → Analysis Tools → Overlay → 

Intersect 

4. Set parameters: 

o Input Features: Select the layers 

o Output Feature Class: Provide location + 

name 

o Output Type: Usually INPUT 

5. Click OK. 

6. Review output geometry and combined attribute table. 

Common Issues 

• Large attribute table due to combined fields 

• Empty output if layers do not overlap 

• Sliver polygons due to small misalignments 

 

Union 

Union overlays two or more polygon layers and creates a new layer containing all areas from 

all layers. It preserves full spatial extent and attributes of every input. 

Union tool only works with polygon layers. 
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Steps: 

1.   Add two or more polygon layers.  

2.   Ensure projections match. 

3.   Open: ArcToolbox → Analysis Tools → 

Overlay → Union 

4.   Set parameters: 

• Input Features: Select polygon layers 

• Output Feature Class: Provide location + 

name 

• Gaps Allowed: Leave checked unless you 

want to remove small gaps 

5.   Click OK. 

6.   Inspect new subdivided polygons and attributes. 

Dissolve 

Dissolve merges polygon features that share a common attribute value. Internal boundaries are 

removed and a simplified feature is created. Numeric fields can be aggregated. 

Used for: 

• Creating district boundaries from Upazilas 

• Simplifying map layers 

• Aggregating area/length statistics 

Steps 

1.   Add polygon layer. 

2.   Open: ArcToolbox → Data Management Tools → Generalization → Dissolve 

3.   Set parameters: 

• Input Features: Select polygon layer  

• Output Feature Class: Provide name 

• Dissolve Fields: Choose attributes for grouping 

• Statistics Fields (optional): Choose numeric fields + statistic types (Sum, Mean, 

Min, Max) 

4.   Click OK. 

5.   Inspect output layer for simplified geometry. 
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GIS Visualization and Map Layout  

Hasan Mahmud, Senior System Analyst, Computer & GIS Unit  

Bangladesh Agricultural Research Council 

Email: hasan.mahmud@barc.gov.bd 

 
A page layout (often referred to as a layout) is a collection of map elements organized on a 

virtual page, designed for map printing. Common map elements that are arranged in the layout 

include one or more data frames (each containing an ordered set of map layers), a scale bar, 

north arrow, map title, descriptive text, and a symbol legend. 

 

FIGURE: KEY ELEMENTS OF THE PAGE LAYOUT USER INTERFACE 

In Layout view we can add map elements such as north arrows, legends, and scale bars, as well 

as, frames that contain the geographic data or the maps themselves. Other finishing touches can 

be added to a Layout using a full suite of graphics and graphic editing tools. Rulers 

and guides can be used in the Layout View to help accurately measure and organize the 

elements on the page. What we see on the layout is what we get if we print or export the map to 
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the same page size. 

Creating a New Page Layout 

The first step in ArcMap is to change your map view to layout—either by selecting Layout 

View from the View menu or by clicking the Layout View button on the lower left of the map 

display 
 

In order to save time, we may want to consider using a template to preconfigure your layout. 

When starting a new document, we can use one of the templates included with ArcMap or 

create your own. 
 

 
FIGURE: LAYOUT TEMPLATES 

Using a template is optional.  

Once we are working in layout view, we can set up your page orientation and dimensions using 

the Page and Print Setup dialog box. 

When we create a new document from a template, an untitled map is opened based on the 

selected template. These templates are listed under the My Templates node under New Maps. 
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Figure: Open existing maps or create new 

 
The Select Template dialog box 

User and system templates are also available when changing your page layout in the Select 

Template dialog box. New templates are available in the Select Template dialog box from the 

same user profile and system location used by the Getting Started dialog box. 
 

Figure: Change page layout with a user-defined template under  

             My Templates or a  system template from Templates
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Change your page layout with a user-defined template under My Templates or a system 

template from Templates. 

To open the Select Template dialog box, click the Change Layout button    on 

the Layout toolbar. 

 

Adding a data frame to the page layout 

The data frame displays a collection of layers drawn in a particular order for a given map extent 

and map projection. We can add a data frame to the page layout using the Insert menu. 
 

From this menu, we can insert additional data frames. These additional data frames may be for 

locator or detail maps. If we are using multiple data frames we may want to consider using extent 

indicators to show the extent of one data frame within another data frame. A good locator map 

will also contain an indicator, such as an outline, showing where the extent of the detail map 

fits within a larger extent. For example, your locator map might show the location of a state 

within a country. 

When your map document contains more than one data frame, only one will be the active data 

frame, that is, the one with which we are actively working. The active data frame name is 

shown in bold in the table of contents and the frame will be highlighted on the page with a 

dashed outline. To make a data frame active, right-click on its name in the table of contents 

and select Activate or single-click the data frame on the page layout. 

Adding Other Map Elements to Page Layout 

Use the Insert menu to select other map elements to add to your layout. We can use this menu 

to add a Title to the page. The added text will be the same as the text entered for the title in the 

Map Document Properties dialog box. Along with a title we can add (static) Text and Dynamic 

Text. 
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We can use the Insert menu to add a Legend, North Arrow, Scale Bar, and Scale Text. Clicking 

any of these options opens an appropriate wizard or dialog box where we can set properties for 

each map element. 
 

We can also add Neatlines, pictures, and objects from the Insert menu. 
 

The Draw toolbar can be used to add graphic shapes such as rectangles, lines, and points. We 

can also add graphic text and edit text properties. 
 

 

 

Working with Map Elements 

As we add map elements, we can 

edit their properties, size, 

position, and appearance, and 

arrange them on the page with 

other map elements. From the 

View menu we can toggle on 

Rulers, Guides, and a Grid to aid 

in positioning elements on the 

page. We can also access 

placement aids in the layout view 

context menu. Open this menu by right-clicking the page layout. 
 

We can set properties for these placement tools using the Layout View tab of the ArcMap 

Options dialog box, which is available from the Customize menu. Here, we can set the units 

and division values for the page ruler, and set the spacing for the grid.  

Options on the Layout View tab also include ways to manage the appearance of the layout 

view. We can choose to stretch the contents of the view when the window is resized. 
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To work with individual elements, select the element or elements 

we want to work with and right-click to open the element context 

menu.  Here we can zoom to, Cut, Copy, or Delete the selected 

element or elements from the page layout. In some cases we may 

want to convert a dynamic element, such as a legend or scale bar, 

to graphics in order to apply greater control over their display. The 

menu provides options to Group or Ungroup elements. Grouping 

elements is a good way of managing a page layout with many 

elements. 

This menu also provides commands to further manipulate graphics 

through Graphic Operations and placement commands. Placement 

commands include the ability to place elements in a specified 

drawing Order, Nudge, or move the element in a particular 

direction, Align, and Distribute multiple elements on the page. We 

can also Rotate or Flip an element. 

We can change the size of map elements by selecting them and dragging the selection handles. 

Dragging a handle in either direction will resize the element. We can also use the element's 

properties dialog box—Size and position tab—to position the element.  

Working with a Page Layout 
 

The Layout toolbar is used to navigate the page layout. It is enabled when we are in layout 

view. We can pan and zoom in/out on the page. We can also jump back and forth to previous 

page extents or specify a zoom percentage based on the page size. Other options for navigating 

in the page layout include the Layout View context menu, changing the active tool into a 

navigation tool by using the keyboard, and using the mouse wheel to zoom in and out.  

  

We can access the layout context menu by right-clicking in any open 

area on the page. The layout context menu offers ways to work with 

the page layout. Along with access to the placement aids (Rulers, 

Guides, Grid, and Margins), this context menu provides a few  

commands to quickly change the view of the page, access the Page and 

Print Setup dialog box, Toggle Draft Mode, and work with selected 

elements. 
 

When in draft mode, using Toggle Draft Mode, the contents of the page 

elements are not drawn. Instead, only the bounding box of the frame 

and a label showing its name are drawn. We can control draft mode 

for individual elements through the Frame tab of the element's 

Properties dialog box. 
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Grids and Graticules 

Grids and graticules are used to display coordinate positions on the earth. Graticules show lines 

of latitude and longitude for the earth, while grids show measured locations based on a 

coordinate system or can be used as a reference system for a grid index. For example, we can 

place a grid that divides a map into a specified number of rows and columns by choosing the 

reference grid type. 
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ArcMap has three ways in which we can add grids and graticules to your map 

• Grids and Graticule Wizard 

• Custom overlay reference grids 

• Grid and Graticule layers 

Deciding which option to use depends on the requirements of the grid or graticule used in the 

map. 

Printing and Exporting Layout 

Once we have completed this work on your layout, we can print your 

map or create other types of output formats—PDF files, PostScript 

files, or Illustrator files. Under the file menu we have the options to 

open the Page and Print Setup dialog box, Print Preview, Print the 

page, or to Export Map. 
 

 

 

Reference: 

Esri. 2023. Using map templates 

https://desktop.arcgis.com/en/arcmap/latest/map/page-layouts/using-mxd-templates.htm 

 

 

 

 

 

 

 

 

 

 

 

https://desktop.arcgis.com/en/arcmap/latest/map/page-layouts/using-mxd-templates.htm
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Exercise 
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Basic Concepts of Remote Sensing Technology  

Hasan Mahmud, Senior System Analyst, Computer & GIS Unit  

Bangladesh Agricultural Research Council 

Email: hasan.mahmud@barc.gov.bd 

 

1. Introduction to Remote Sensing 

Remote sensing is the science of obtaining information about objects or areas from a distance, 

typically using satellite or aerial sensor technologies. It plays a crucial role in monitoring and 

managing natural resources, urban planning, agriculture, disaster response, and climate studies. 

The technology leverages electromagnetic radiation to gather data without direct contact with 

the subject.  

A formal definition: 

"Remote sensing is the science (and to some extent, art) of acquiring information about the 

Earth's surface without actually being in contact with it. This is done by sensing and recording 

reflected or emitted energy and processing, analyzing, and applying that information." 

2. Electromagnetic Spectrum and Radiation Principles 

Remote sensing relies on electromagnetic radiation (EMR), which is emitted or reflected by 

objects. The EM spectrum includes various wavelengths from gamma rays to radio waves. 

Different materials reflect, absorb, or emit EM radiation uniquely, allowing remote sensors to 

identify and analyze them through their spectral signatures. 
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3. Interactions with Atmosphere and Earth's Surface  

Before reaching sensors, radiation interacts with the atmosphere through scattering and 

absorption. Upon striking the Earth, radiation may be absorbed, transmitted, or reflected, 

depending on surface characteristics. Vegetation, water, and soil each exhibit distinct 

reflectance patterns across wavelengths. 

 

4. Remote Sensing Systems: Passive and Active 

Remote sensing systems can be classified as passive or active. Passive systems detect natural 

energy (typically from the sun) reflected by the surface, while active systems emit their own 

signal and measure its reflection. Examples include optical sensors (passive) and radar 

systems (active). 

 

 

5. Types of Resolutions 

Resolution in remote sensing defines the 

level of detail. The four primary types are: 
 

Spatial: Size of the smallest object     

detectable. 
 

Spectral: Number and width of spectral   

bands. 
 

Temporal: Frequency of data acquisition. 
 

 

Radiometric: Sensitivity to differences in signal strength. Represented as how many bits are 

used to represent a reflectance value. 
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6. Satellites, Orbits, and Sensors 

Satellites operate in various orbits - geostationary, polar, or sun-synchronous - each serving 

different observation purposes. Sensors onboard these satellites, such as MODIS, Landsat 

OLI, and Sentinel-1 SAR, differ in design and application. Key satellite parameters include 

orbit type, swath width, and revisit time. 
 

Parameter Sentinel-1 Sentinel-2 Landsat-8 Landsat-9 
MODIS 

(Terra/Aqua) 

Orbit Sun-synchronous, Near-polar 

Altitude ~693 km ~786 km ~705 km ~705 km ~705 km 

Repeat 

Cycle 

12 days 

(6 days 

A+B) 

10 days (5 

days A+B) 
16 days 

16 days (8 

days 

Landsat-8) 

1-2 days (near-

global daily) 

Sensor C-SAR MSI 
OLI & 

TIRS 

OLI-2 & 

TIRS-2 
MODIS 

Resolution 5-20 m 
10 m, 20 m, 

60 m 

15 m (pan), 30 m (MS), 

100 m (Thermal) 

250 m, 500 m,  

1 km 

Swath 

Width 
80-400 km 290 km 185 km 185 km 2330 km 

Spectral 

Bands 

HH, VV, 

HV, VH 
13 

9 (Vis, NIR, SWIR, Pan) 

+ 2 (Thermal) 

36 

(Visible to 

Thermal IR) 
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Data Type 

Radar 

Backscatter 

(Intensity 

& Phase) 

TOA 

Reflectance 

TOA Reflectance, 

Thermal Radiance 

Radiance, 

Reflectance, 

Temperature, 

Indices, etc. 

7. Data Processing Levels 

Satellite data is processed in levels: 

      - Level 0/1: Raw Sensor Data. 

      - Level 2: Geophysical Variables (e.g., surface temperature). 

      - Level 3: Gridded, Calibrated data, Quality Controlled Data. 

      - Level 4: Model-assimilated products. 

 

8. Optical Vs Radar 

 

 

Feature Optical Imagery Radar Imagery (SAR) 

Sensor Type 
Passive (detects reflected/emitted 

light) 

Active (emits and receives 

microwaves) 

Illumination Sun (mostly), thermal emission Self-illuminated (microwaves) 

Weather Affected by clouds, fog, smoke Can penetrate clouds, fog, smoke 

Day/Night Primarily daytime Day and night 

Penetration Limited 
Can penetrate vegetation, some 

ground 

Data 

Captured 

Spectral reflectance (color, 

vegetation health, composition) 

Surface roughness, dielectric 

properties, geometry 
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Image Look Visually intuitive (photo-like) 
Grayscale, textural, requires 

specific interpretation 

Resolution Can be very high High (with SAR processing) 

 

 

9. Important Indices 

NDVI, NDWI, NDSI, and EVI are key vegetation and land surface indices derived from 

multispectral satellite data. NDVI uses red and NIR bands to assess vegetation greenness, while 

NDWI (using NIR and SWIR) monitors vegetation water content and open water. NDSI (using 

green and SWIR) is designed for snow detection. EVI is an enhanced vegetation index utilizing 

blue, red, and NIR bands to minimize atmospheric and soil noise and reduce saturation in dense 

vegetation, offering a more robust measure compared to NDVI in certain environments. The 

Leaf Area Index (LAI) is a crucial biophysical parameter that quantifies the amount of leaf 

material present in a plant canopy or ecosystem. Defined as one-half of the total green leaf area 

per unit horizontal ground surface area (for broadleaf canopies) or a related measure for 

coniferous canopies. Each index provides specific insights into surface characteristics but has 

limitations related to atmospheric conditions, background influences, and the specific 

properties they aim to measure. 

 

NDVI = (NIR - Red) / (NIR + Red)  

NDWI (Common) = (NIR - SWIR) / (NIR + SWIR)  

NDSI = (Green - SWIR) / (Green + SWIR)  

EVI = G * ((NIR - Red) / (NIR + C1 * Red - C2 * Blue + L))  

(where G, C1, C2, and L are adjustment factors) 

10. Advantages and Challenges 
 

Advantages: 

- Provides data where ground access is limited 

- Offers global coverage and consistent observations 

- Supports real-time and historical analysis 

- Information on non-visible regions of the spectrum 

Challenges: 

      -    Balancing resolution parameters 

      -    Data volume and complexity 

      -    Need for calibration and validation 

      -    Costly high resolution Imagery 

 

References: 

❖ NASA’s Applied Remote Sensing Training Program 

❖ Canada Centre for Remote Sensing Remote Sensing Tutorial 

❖ Tutorial by TELECAN on Fundamentals of Remote Sensing 
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A Simple Illustration of Bands (Practical) 

In this exercise we will check how do the individual channels/bands (RGB) looks that are 

present in our standard jpg, png images.  

 

 

All 3 Channels Composite 

 

 

 

Only Red Channel 
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Only Green Channel 

 

 
 

Only Blue Channel 

 

For True Color Composite:   

Red => Band_1 

Green => Band_2 

Blue => Band_3 

 

Try assigning any others bands (except Band-1) to Red channel. Observe the effects. 

This is the foundation of false-color composite. 
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Introduction to LiDAR Remote Sensing 

Dr. Md. Golam Mahboob, PSO (Forestry), NRM Division 

Bangladesh Agricultural Research Council 
Email: golam.mahboob@barc.gov.bd 

 

Overview 

 

LiDAR (Light Detection And Ranging) is a remote sensing technology that uses laser pulses 

to measure distances and create precise 3D representations of the Earth's surface. It is widely 

used in forestry, agriculture, environmental monitoring, urban planning, and geological studies. 

 

   
 

 

 

Principles of LiDAR 

 

The basic principle of laser ranging is the measurement of the time it takes for a laser signal to 

travel from the transmitter to the reflecting surface of a target and back to the receiver. 

 

 𝐷 = 𝑐 ×
𝑡

2
  

     

Here,  D is the measured distance 

            c is the speed of light (3×108 m/s) 

 t is the pulse travel time 

 

Types of LiDAR  

  

Figure-1: LiDAR Data Acquisition Figure- 2: 3D Point Cloud 

 

Figure-3: LiDAR Measurement 

  Satellite LiDAR 

    Used in global mapping applications. 

 
  Airborne LiDAR 

    Mounted on aircraft or drones to map  

    large areas. 

 
 

  Terrestrial LiDAR 

    Fixed or mobile ground-based systems  

    for detailed mapping. 

 

Figure-4: Types of LiDAR 

mailto:golam.mahboob@barc.gov.bd
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Components of LiDAR System 

  Laser Scanner 

    Emits laser pulses 

  Laser receiver 

    Records reflected energy 

  GNSS Receiver: 

    Provides positional accuracy 

  Inertial Measurement Unit (IMU) 

    Tracks movement and orientation. 

  High-precision clock 

    Synchronizes all sensors  

  Onboard software 

    Manage systems and store data  

  Optical/infra-red camera  

    Optional, for photograph or video capture 

 

Applications in Environmental Science 

Forestry: Measuring tree height, biomass estimation, and canopy structure analysis. 

Agriculture: Precision farming and land-use classification. 

Hydrology: Monitoring water flow, flood modeling, and watershed management. 

Geology: Terrain mapping, fault detection, and slope stability assessment. 

 

Advantages of LiDAR 

✔ High spatial accuracy  

✔ Rapid data acquisition  

✔ Works in varying light conditions  

✔ Suitable for large-scale mapping 
 

Limitations 

  High cost of equipment  

  Requires specialized data processing skills  

  Laser penetration affected by water bodies 
 

Prospects 

LiDAR technology is advancing with improved sensors, AI-driven data processing, and 

integration with satellite imaging for enhanced environmental analysis. 
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Applications of LiDAR Remote Sensing in Natural Resources Management 
 

1. Introduction to LiDAR Remote Sensing 

LiDAR (Light Detection and Ranging) is an advanced remote sensing technology that uses 

laser pulses to measure distances and generate high-resolution 3D representations of the Earth's 

surface. It is widely used in natural resources management due to its ability to provide precise 

and detailed spatial data. 

Key Features of LiDAR: 

  High-resolution topographic mapping 

  Ability to penetrate vegetation canopy 

  Precise elevation measurements 

  Generation of 3D models for environmental analysis 

2. Applications in Forestry Management 

LiDAR plays a crucial role in forestry by offering detailed insights into forest structure, health, 

and biomass estimation. 

Forestry Applications: 

  Tree Height & Density Mapping 

Helps estimate forest canopy height and tree distribution. 

  Biomass & Carbon Stock Assessment 

Measures forest biomass for carbon sequestration studies. 

  Forest Inventory & Species Classification 

Identifies tree species and assesses forest composition. 

  Deforestation & Habitat Monitoring 

Tracks forest loss and its impact on biodiversity. 

 
 

3. Applications in Watershed & Hydrology Management 

LiDAR data significantly enhances hydrological studies by improving terrain analysis and 

flood modeling. 

Hydrological Applications 

  Watershed Delineation 

Figure-1: Forest Biomass Mapping from LiDAR Data 
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Defines drainage basins and water flow paths. 

  Flood Risk Assessment  

Creates accurate floodplain maps for disaster preparedness. 

  Riparian Zone Analysis 

Identifies vegetation along rivers, improving conservation planning. 

  Groundwater & Surface Water Interaction Studies 

Assists in evaluating water movement and storage. 

 
 

4. Applications in Agriculture & Land Use Planning 

LiDAR supports precision agriculture and sustainable land use management. 

 

Agricultural Applications: 

  Soil Erosion & Terrain Mapping 

Assesses landforms to mitigate soil degradation. 

  Crop Health & Yield Prediction 

Analyzes plant growth patterns for precision farming. 

  Irrigation Planning 

Optimizes water distribution based on terrain slope and elevation. 

  Land Use Classification 

Differentiates agricultural, urban, and natural landscapes. 
 

 

 

 

 

 

 

 

 

5. Applications in Biodiversity & Wildlife Conservation 

LiDAR contributes to ecological studies by enhancing habitat mapping and species monitoring. 

Figure-2: Urban Flood Hazard Maps, doi: https://doi.org/10.3390/w11091832   

Figure-3: a. LiDAR Scanner, b. Mobile LiDAR System, c. Collected Point Clouds from Crop Field 

https://doi.org/10.3390/w11091832
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Conservation Applications: 

  Habitat Suitability Analysis 

Identifies critical habitats for endangered species. 

  Vegetation Structure Assessment 

Evaluates forest canopy for biodiversity conservation. 

  Wildlife Corridor Planning 

Supports strategic conservation for species movement. 

  Mapping Invasive Species Spread 

Detects vegetation changes to manage invasive species. 
 

 
 

 
 

 

6. Future Prospects & Emerging Applications 

  Integration with AI & Machine Learning 

Enhances automated feature detection. 

  LiDAR for Coastal & Marine Studies 

Expands applications to underwater ecosystems. 

  Advancements in Drone-Based LiDAR 

Increases accessibility for localized monitoring. 

  Climate Change Impact Studies 

Supports long-term environmental assessments. 

 

Conclusion: 

LiDAR remote sensing is revolutionizing natural resources management by providing high-

precision data for environmental monitoring, conservation, and sustainable development. Its 

integration with GIS and AI offers promising advancements for future applications. 

Figure-4: Habitat suitability maps for red tree voles derived from airborne LiDAR at 

(A) full (10.36 pulses/m2 ) and reduced point densities of (B) 4 points/m2 and 

(C) 1 point/m2 in southwestern Oregon, USA, doi: 10.1002/jwmg.21173  

https://doi.org/10.1002/jwmg.21173
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Open-Source Satellite Imagery 
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Email: zohiruddin.omor@care.org 

 

There are several open-source and publicly available satellite imagery sources that provide 

coverage of Bangladesh. These are useful for monitoring agriculture, urban growth, flooding, 

deforestation, and more. Here's a list of some of the best platforms and datasets: 

1. Sentinel Hub (European Space Agency - ESA) 

• Satellites: Sentinel-1 (radar), Sentinel-2 (optical) 

• Resolution: 10–20 meters (Sentinel-2), all-weather radar (Sentinel-1) 

• Update frequency: Every 5 days (Sentinel-2) 

• Use cases: Land use, vegetation, flood mapping 

• Access: https://apps.sentinel-hub.com/eo-browser 

2. NASA Earthdata (via LP DAAC and Earthdata Search) 

• Satellites: MODIS (Terra & Aqua), Landsat, VIIRS 

• Resolution: 

MODIS: 250m–1km (daily) 

Landsat: 30 meters (16-day revisit) 

• Use cases: Climate monitoring, long-term land change 

• Access: https://search.earthdata.nasa.gov/  

3. USGS Earth Explorer 

• Satellites: Landsat series, others 

• Resolution: 30 meters (Landsat), 10 meters (Sentinel-2) 

• Use cases: Historical land cover change, hydrology, urban planning 

• Access: https://earthexplorer.usgs.gov/  

4. Google Earth Engine (GEE) 

• Type: Cloud-based geospatial processing 

• Data: Landsat, Sentinel, MODIS, many more 

• Use cases: Custom time-series analysis, deforestation, flood mapping 

• Access: https://earthengine.google.com/  

Note: Requires an application for access (free for research, NGOs, and developers) 

5. OpenAerialMap 

• Type: Open aerial imagery contributed by users and organizations 

• Use cases: Post-disaster mapping, infrastructure 

• Access: https://openaerialmap.org/  

6. Radiant Earth Foundation 

• Type: Open ML-ready earth observation data 

• Use cases: Agriculture, humanitarian response, ML models 

• Access: https://radiant.earth/  

mailto:zohiruddin.omor@care.org
https://apps.sentinel-hub.com/eo-browser
https://search.earthdata.nasa.gov/
https://earthexplorer.usgs.gov/
https://earthengine.google.com/
https://openaerialmap.org/
https://radiant.earth/


72 | P a g e  

 

Steps to download sentinel 2 data from Copernicus sentinel hub 

Sentinel-2: 

To download Sentinel-2 data from the Copernicus Sentinel Hub (ESA), you can follow these 

steps. There are two main ways: via the EO Browser (user-friendly interface) 

Open EO Browser: 

Create a (free) account: 

• Click “Log in” or “Sign up” (free for public and research use). 

• You need an account to download high-resolution imagery. 

 

 
Select Area of Interest (AOI): 

• Use the search bar or draw a polygon/rectangle on the map to define your area. 

 
Select Satellite and Data Source: 

• Choose Sentinel-2 L1C (Top-of-atmosphere reflectance) 

• Or Sentinel-2 L2A (Surface reflectance, atmospherically corrected) 



73 | P a g e  

 

 
Choose Time Range: 

• Select a date range in the top-left panel to filter available scenes. 

 
Browse and Preview Data: 

• Click on a result to preview the scene. 

• Use the drop-down to choose band composites (e.g., True color, NDVI, etc.) 
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Download the Image: 

• Click "Download" (bottom right). 

• Set resolution and bands to export (e.g., B2, B3, B4, B8) 

 
 

 

Landset 8/9 

Create a (free) account: 

• Click “Log in” or “Sign up” (free for public and research use). 

• You need an account to download high-resolution imagery. 
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Select Area of Interest (AOI): 

Use the search bar or draw a polygon/rectangle on the map to define your area. 

 

 
 

 

 

Data Set Selection: 

From the second button all data set can view in the list and select Landsat data. 
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Browse and Preview Data: 

Click on a result to preview the scene and use the drop-down to choose band composites. 

 

 
 

Download the Image: 

Click "Download" from the pop-up box for need or purpose basis. 
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Creates a single raster dataset from multiple bands. 

 

 
Source: ESRI 
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Uses of Band Composite: 

• This tool can also create a raster dataset containing subset of the original raster dataset 

bands. This is useful if you need to create a new raster dataset with a specific band 

combination and order. 

• The order that the bands are listed in the Multi-value Input control box will determine 

the order of the bands in the output raster dataset. 

• This tool can only output a square cell size. 

• You can save your output to BIL, BIP, BMP, BSQ, DAT, Esri Grid , GIF, IMG, JPEG, 

JPEG 2000, PNG, TIFF, MRF, CRF, or any geodatabase raster dataset. 

• The output raster dataset takes the cell size from the first raster band in the list. 

• By default, the output raster dataset takes the extent and the spatial reference of the first 

raster band with a spatial reference in the list. You can change this by setting the output 

extent and output coordinate system in the Environment Settings. 

 

The following are some examples of why you would want to combine single raster datasets 

into multiband raster datasets: 

• You may have received some satellite data where each band of data is contained in a 

single file—for example, band1.tif, band2.tif, and band3.tif. To render these raster 

datasets together to create a color composite, each band needs to be contained within a 

single raster dataset (for example, allbands.tif). 

• You may have several raster datasets of the same area captured at various times. By 

displaying these raster datasets as a color composite, you can detect change in the area, 

such as urban growth or cut forests. To create this color composite, each raster dataset 

needs to be contained as individual bands within a single raster dataset. 

• In some cases, the output of an analysis operation is a single-band raster dataset. To do 

further visual analysis, you may need to combine the outputs by rendering your data as 

a color composite. 

• Combining bands into one raster dataset can help you organize many related single-

band rasters. 
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Layer Stack/Composite Bands of Satellite Image 
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Composite bands in satellite imagery refer to combining multiple spectral bands (channels) 

into a single image to highlight specific features or patterns on Earth's surface. Different band 

combinations (also called "band composites") are used to visualize and analyze different land 

cover types, vegetation, water bodies, urban areas, etc. 

Common Types of Band Composites 

1. True Color Composite 

• Bands Used (e.g., Sentinel-2): Red (B4), Green (B3), Blue (B2) 

• What It Shows: Similar to what the human eye sees 

• Use Case: General visualization, urban mapping 

 

2. False Color (Infrared) Composite 

• Bands Used: NIR (B8), Red (B4), Green (B3) 

• What It Shows: Vegetation appears red; healthy vegetation is very bright 

• Use Case: Vegetation health, crop analysis 

 

3. Shortwave Infrared (SWIR) Composite 

• Bands Used: SWIR1 (B11), NIR (B8), Red (B4) 

• What It Shows: Useful for distinguishing water, snow, burn scars, and soil moisture 

• Use Case: Flood detection, burn area mapping 

 

4. Urban/Man-Made Feature Composite 

• Bands Used: SWIR (B12), NIR (B8A), Red (B4) 

• What It Shows: Enhances man-made structures; urban areas appear distinct 

• Use Case: Urban growth monitoring 

 

 

 

 

mailto:zohiruddin.omor@care.org
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Composite Bands in ArcMap 10.8 

Creates a single raster dataset from multiple bands. 

 
                                               Source: ESRI 

Usage 

• This tool can also create a raster dataset containing subset of the original raster dataset 

bands. This is useful if you need to create a new raster dataset with a specific band 

combination and order. 

• The order that the bands are listed in the Multi-value Input control box will determine 

the order of the bands in the output raster dataset. 

• This tool can only output a square cell size. 

• You can save your output to BIL, BIP, BMP, BSQ, DAT, Esri Grid , GIF, IMG, JPEG, 

JPEG 2000, PNG, TIFF, MRF, CRF, or any geodatabase raster dataset. 

• The output raster dataset takes the cell size from the first raster band in the list. 

• By default, the output raster dataset takes the extent and the spatial reference of the first 

raster band with a spatial reference in the list. You can change this by setting the output 

extent and output coordinate system in the Environment Settings. 

• The following are some examples of why you would want to combine single raster 

datasets into multiband raster datasets:  
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✓ You may have received some satellite data where each band of data is contained in 

a single file—for example, band1.tif, band2.tif, and band3.tif. To render these raster 

datasets together to create a color composite, each band needs to be contained within 

a single raster dataset (for example, allbands.tif). 

✓ You may have several raster datasets of the same area captured at various times. By 

displaying these raster datasets as a color composite, you can detect change in the 

area, such as urban growth or cut forests. To create this color composite, each raster 

dataset needs to be contained as individual bands within a single raster dataset. 

✓ In some cases, the output of an analysis operation is a single-band raster dataset. To 

do further visual analysis, you may need to combine the outputs by rendering your 

data as a color composite. 

✓ Combining bands into one raster dataset can help you organize many related single-

band rasters. 

 

Example Steps by Steps 

A multiband raster from Landsat 8 band images can be created in ArcMap, either by using the 

Composite Bands (Data Management) tool or the Composite Bands button in the Image 

Analysis window. 

 

The instructions provided describe how to create a multiband raster from Landsat 8 band 

images. 

Option A: 

 

Use the Composite Bands (Data Management) tool. 

 

1. In ArcMap, navigate to Geoprocessing > ArcToolbox > Data Management Tools > Raster 

> Raster Processing > Composite Bands. 

2. Click the browse button, and search for the desired input raster. 

 

 

3. Specify the name and location of the output raster, and click OK. 
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Note: 

 If working outside a geodatabase, specify the extension of the output raster.  

 

 

Option B: 

 

Use the Composite Bands button in the Image 

Analysis window. 

 

1. In ArcMap, add the raster bands to 

the map document. 

2. Navigate to Windows > Image 

Analysis. 

3. In the Image Analysis window, hold 

down the shift key and select the 

band images. 

4. Click the Composite Bands button. 

 

 

Note: 

The output of the Image Analysis window is added to the map document as a temporary layer. 

To save the output layer as a raster dataset, click the Export button on the Image Analysis 

window and specify the output location of the raster dataset.  
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Note: 

The output raster of both options is generated as an RGB composite. To change it to a Stretched 

value composite, right-click the layer > Properties > Symbology. Under the Show section, 

select the 'Stretched' option, and specify the band to be used for the stretch values. Input the 

desired parameters, and click OK.  
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Satellite Image Processing 

Md. Zohir Uddin Omor 
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Satellite Image Processing 

Satellite image processing involves analyzing and interpreting data captured by satellites to 

extract meaningful information. This field combines remote sensing, computer vision, and 

image processing techniques to monitor and manage natural and man-made environments. 

1. Key Steps in Satellite Image Processing: 

1. Image Acquisition 

o Obtaining images from satellite sensors (e.g., Landsat, Sentinel, MODIS). 

o Images may come in various bands (visible, infrared, thermal, etc.). 

2. Preprocessing 

o Radiometric Correction: Adjusting pixel values to account for sensor noise 

and lighting. 

o Geometric Correction: Aligning images to a known coordinate system. 

o Atmospheric Correction: Removing atmospheric effects like haze or clouds. 

o Resampling: Adjusting image resolution or grid alignment. 

3. Image Enhancement 

o Contrast stretching, filtering, and edge enhancement to improve visual 

interpretability. 

4. Image Classification 

o Supervised (e.g., SVM, Random Forest, CNN): Uses labeled training data. 

o Unsupervised (e.g., K-means, ISODATA): Clusters based on pixel 

similarities. 

5. Change Detection 

o Comparing images from different time periods to detect environmental or 

structural changes. 

6. Feature Extraction 

o Identifying objects like roads, buildings, vegetation, or water bodies using 

pattern recognition or deep learning. 

7. Analysis and Visualization 

o Using GIS software (like QGIS, ArcGIS) or programming tools (Python, 

MATLAB) to interpret results and create visual outputs. 

 

Tools and Libraries: 

• Software: ENVI, ERDAS Imagine, SNAP (for Sentinel), QGIS, ArcGIS 

• Programming Libraries: 

o Python: rasterio, gdal, numpy, scikit-image, opencv, tensorflow, pytorch, 

earthpy 

o R: raster, rgdal, sf, terra 

mailto:zohiruddin.omor@care.org
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2. Satellite Image Processing in ArcGIS 

Imagery is processed and used for a wide variety of geospatial applications, including 

geographic context, visualization, and analysis. You may want to apply processing techniques 

on image data, visually interpret the data, use it as a background to aid interpretation of other 

data, or use it for analysis. In this course, you will use tools in ArcGIS to perform basic image 

processing. You will learn how to dynamically modify properties that enhance image display, 

visualize surface features, and create multiple products. 
 

The role of imagery in GIS 

Images and rasters are used in ArcGIS for various reasons: 

• As background to provide reference to geographic data 

• For heads-up digitizing while editing 

• For visually interpreting a site 

• For advanced analysis 
 

Image processing allows you to see information about your data that would have been 

otherwise difficult to extract. Imagery and raster data are integrated into all aspects of 

ArcGIS. Imagery can be used to enhance other geographic data or to provide reference in 

editing, or it can be processed to provide powerful data that is necessary for answering 

complex analysis questions. 

 

 

  

 

What is image processing? 

How would you identify where healthy vegetation is growing in a city? How can you combine 

bands to visualize imagery in natural color? Can you combine a low-resolution natural color 

image and a high-resolution grayscale image in a single image? Image processing can help you 

answer questions like these. 
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Types of image processing 

ArcGIS provides many options for image processing. The image-processing techniques 

described in this graphic allow you to use ArcGIS to extract answers from imagery for analysis. 

 

 

Accessing and enhancing imagery 

You can employ numerous types of image 

formats in ArcGIS for display purposes. 

Several of these format types can be used for 

image processing. It is important to know 

about these formats - and to understand which 

image-processing operations you can perform 

on them -before you start your analysis. 

You can also enhance imagery for visual 

interpretation. Knowing which options you 

can use to change and improve the display can 

help answer questions about your data. 

 

Common imagery types used in processing 

Image processing can be applied to a variety of raster types. This graphic illustrates three 

commonly used types: aerial imagery, satellite imagery, and elevation data. 
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Aerial images are 

photographs of the earth's 

surface, usually taken from 

an aircraft using film or 

digital camera. These 

images are often used for 

image-processing functions 

like pan-sharpening, NDVI, 

and composite. 

Satellite images often consist 

of multiple spectral bands, 

some of which are invisible 

(such as infrared). In this 

Landsat 7 image, bands 5, 4, 

and 1 are represented. A 

Landsat is an earth-orbiting 

satellite that gathers imagery 

for land-use inventory, 

geological exploration, crop 

assessment, and similar 

activities. Satellite images can 

be subjected to a variety of 

image-processing functions 

(pan-sharpening, NDVI, and 

composite etc.). 

Elevation data represents the 

ground (bare earth) or 

surface of the earth 

(including buildings and 

other structures). This image 

is a digital elevation model 

(DEM) representing the 

earth's surface. A common 

image-processing function 

applied to elevation data is 

hillshade. Here, the result is 

a tinted hillshade. 

Enhancing Image Display 

Changing display properties can enhance an image to either prepare it for additional 

processing or answer questions about your data through visual interpretation. You can easily 

access these display options through the Image Analysis window and apply them on the fly to 

avoid altering the original image. 

  

The contrast slider adjusts the displayed 

contrast characteristics of the selected image. 

The image on the right has been enhanced to 

increase contrast. 

The brightness slider adjusts the displayed 

brightness characteristics of the selected 

image. The image on the right has been 

enhanced to increase brightness. 
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The transparency slider adjusts the 

transparency of the selected image, allowing 

for visualization of data under the image. The 

image on the right has been made partially 

transparent to allow the hillshade image 

(another image below the green image) to 

show through. 

 

The gamma slider adjusts the gamma 

transformation of the selected image. The 

gamma refers to the degree of contrast 

between the mid-level gray values of a 

raster dataset. Gamma does not affect the 

black or white values in a raster dataset, 

only the middle values. The image on the 

left has 0, whereas the image on the right has 

.48 applied. 

 

 

 

  

The DRA check box refers to "dynamic range 

adjustment." This allows the brightness and 

contrast of the image display to be adjusted 

based only on the data and contained within 

the data frame extent. That means dark areas 

will automatically brighten, and bright areas 

will automatically darken. The image on the 

left does not have the option checked, whereas 

the image on the right does. 

 

The stretch adjusts the stretch applied to the 

selected image. There are six stretch options 

available: None, Minimum-maximum 

(Min-max), Standard deviation (Std-dev), 

Histogram equalization (Hist-eq), Percent 

clip, and Esri. Different stretches will 

produce different results in the raster 

display. The image on the left has no stretch 

applied (None), whereas the image on the 

right has standard deviation (Std-dev). 
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The resample selection chooses which 

resampling method to apply when you pan and 

zoom to view the selected image. Resampling 

is the process of interpolating the pixel values 

to fit your raster dataset to the desired 

resolution. Resampling methods include 

nearest neighbor, bilinear, cubic convolution, 

and majority. 

 

 

 

 

 

Common Image Processing Techniques 

Image processing can make imagery more useful and informative. Using image-processing 

techniques allows you to extract information for use in analysis. ArcGIS offers many options 

for image processing. Now, you will learn about four specific examples of image-processing 

functions: hillshade, composite, NDVI, and pan-sharpening. 

Image Classification 

Image Classification in remote sensing is the process of assigning land cover or land use 

classes (e.g., water, vegetation, urban) to each pixel in a satellite image based on its spectral 

characteristics. Image classification refers to the task of extracting information classes from a 

multiband raster image. The resulting raster from image classification can be used to create 

thematic maps. Depending on the interaction between the analyst and the computer during 

classification, there are two types of classification: supervised and unsupervised. 

With the ArcGIS Spatial Analyst extension, there is a full suite of tools in the Multivariate 

toolset to perform supervised and unsupervised classification (see An overview of the 

Multivariate toolset). The classification process is a multi-step workflow, therefore, the Image 

Classification toolbar has been developed to provided an integrated environment to perform 

classifications with the tools. Not only does the toolbar help with the workflow for performing 

unsupervised and supervised classification, it also contains additional functionality for 

analyzing input data, creating training samples and signature files, and determining the quality 

of the training samples and signature files. The recommended way to perform classification 

and multivariate analysis is through the Image Classification toolbar. 

 

Supervised Classification 

Supervised classification uses the spectral signatures obtained from training samples to classify 

an image. With the assistance of the Image Classification toolbar, you can easily create training 

samples to represent the classes you want to extract. You can also easily create a signature file 

from the training samples, which is then used by the multivariate classification tools to classify 

the image. 

 

Unsupervised Classification 

Unsupervised classification finds spectral classes (or clusters) in a multiband image without 

the analyst’s intervention. The Image Classification toolbar aids in unsupervised classification 
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by providing access to the tools to create the clusters, capability to analyze the quality of the 

clusters, and access to classification tools. 

 

Example 

In the following example, the Image Classification toolbar was used to classify a Landsat TM 

satellite image. 

The following raw satellite image is a four-band Landsat TM image of the northern area of 

Cincinnati, Ohio. 

 
Input Landsat TM image 

Using the toolbar, five land-use classes were defined from the satellite 

image: Commercial/Industrial, Residential, Cropland, Forest, and Pasture. 

 
Training Samples 

 

The quality of the training samples was analyzed using the training sample evaluation tools 

in Training Sample Manager. 
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Evaluating Training Samples                                                                                                          

Using the Image Classification toolbar and Training 

Sample Manager, it was determined the training 

samples were representative for the area and 

statistically separate. Therefore, a maximum 

likelihood classification was performed from the 

toolbar. The classified image was then cleaned to 

create the final land-use map as shown below. 

 

Output Classified Land Use Map 

Change Detection 

Temporal change detection can be performed by 

comparing two rasters from a different time, such as 

detecting changes in vegetation cover, or land use over 

a specified period. This can be done with the Raster Calculator in ArcMap, which gives results 

that allow further interpretation and classification for quantifying areas of change. 

The images below show vegetation cover for years 2005 and 2017. The instructions provided 

describe how to detect and quantify vegetation cover changes from 2005 to 2017 using the 

Raster Calculator tool. 
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Procedure 

1. Subtract NDVI rasters for the difference in pixel values over time. 

Note:  

The NDVI rasters must cover the same spatial extent, and the pixels must be perfectly 

aligned. Additionally, to detect annual changes, acquire NDVI rasters calculated for the 

same window of the year. Otherwise, NDVI rasters calculated in different seasons 

reflect vegetation changes over seasons, and not years. 

a. Navigate to Spatial Analyst Tools > Map Algebra > Raster Calculator. 

b. In the Raster Calculator dialog box, type the expression required to subtract the 

raster of a previous time from the raster of a later time. For example: 
 

 
 

c. Set a name and location for the Output raster. 

d. Click OK. The output raster contains the subtracted cell values. Negative values 

indicate losses while positive values indicate gain. Zero '0' indicates unchanged 

vegetation cover. 



93 | P a g e  

 

 
 

2. The raster generated in Step 1 can be classified into multiple classes to reflect 

vegetation change direction and extent. For example, (a) Vegetation loss; (b) No 

change, and (c) Vegetation gain, or (a) Significant loss; (b) Loss; (c) No change; (d) 

Gain, and (e) Significant gain. 

a. Navigate to Spatial Analyst Tools > Reclass > Reclassify. 

b. Select the output raster from Step 1 for Input raster. 

c. Select VALUE for Reclass field. 

d. Under Reclassification, click Classify.... 
 

 
 

e. In the Classification dialog box, select a method for the classification in 

the Method drop-down list, and select the desired number of classes in 

the Classes drop-down list. 

f. Set the Break Values manually, if necessary. 
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g. Click OK to exit the Classification dialog box. 

h. In the Reclassify dialog box, set a name and location for Output raster. 

i. Click OK. A reclassified raster is generated with pixel values indicating the 

vegetation change classes. A Count field is added to the attribute table of the 

reclassified raster containing the number of cells falling into each class. 

 

 
 

3. Quantify the changes by creating a new field, and calculate the area of each class by 

multiplying the Count field with the pixel size of the raster layer. 

a. Open the attribute table of the output in Step 2. Right-click the layer and 

click Open Attribute Table. 

b. Click Table Options > Add Field. 

c. In the Add Field dialog box, type a name for the new field. Select Double as the 

field type. Leave other settings at default, and click OK. 

d. Right-click the new field > Field Calculator. Click Yes if a prompt dialog 

displays. 

e. In the Field Calculator dialog box, multiply the Count field by the pixel size of 

the raster layer. For example, this raster's pixel size is 90. 
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f. Click OK. The area for each class is calculated in the new field. The unit of the 

calculated area is the unit of the raster's coordinate system. 
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GIS and Remote Sensing Works in Crop Zoning Project 

Hasan Md. Hamidur Rahman, Director (Computer & GIS Unit) 

Bangladesh Agricultural Research Council 

Email: h.rahman@barc.gov.bd 

 

Background 

➢ Bangladesh Agricultural Research Council (BARC) has been developing the crop 

zoning system for maintaining a sustainable agricultural production system in order to              ensure 

long-term food security for the people. 

➢ The government of Bangladesh put emphasis on crop zoning based land use planning 

in 8th five year plan policies and strategies of the crop sub-sector. 

➢ On February 4, 2021, at the unveiling ceremony of “The 100 Agro Technologies Atlas" 

published by BARC, the Honorable Prime Minister of Bangladesh mentioned the necessity for 

crop zoning and requested to take action in this regard. 

 

Basic Information 

 

• Implementing Organization: 

Bangladesh Agricultural Research Council (BARC) 

 

• Partner Organizations: 

1. Soil Resource Development Institute (SRDI)  

2. Institute of Water Modeling (IWM) 

 

• Focal Point Organizations: 

1. Department of Agriculture Extension (DAE) 

2. Bangladesh Agricultural Research Institute (BARI) 

3. Bangladesh Rice Research Institute (BRRI) 

4. Bangladesh Institute of Nuclear Agriculture (BINA) 

5. Bangladesh Wheat & Maize Research Institute (BWMRI) 

 

Objectives 

The overall objective is to develop crop zoning in support of GoB’s strategy to facilitate a more 

efficient and sustainable agricultural production systems in the context of food and nutritional 

security of the country. More specifically the objectives are: 

• Provide crop zoning information to agricultural policy planners/ decision makers in 

creating a “farm friendly” policy framework to sustain an economically viable agriculture 

sector through conserving and protecting farmland for current and future generations; 

• Facilitate and strengthen farmers and other stakeholders’ access to information on suitable 

crop, fertilizer recommendation and others related to increased agricultural productivity and 

farm income; 

• Awareness building on the utility and use of crop zoning information system to help 

farmers, extension personnel, policy makers’ transition to more sustainable agricultural system. 

mailto:h.rahman@barc.gov.bd
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Figure: Crop Suitability Assessment Framework 

 

Data used in Crop Zoning 

❑ Upazila wise land and soil characteristics, soil chemical properties and soil and 

topography maps. 

❑ 30 years (1988-2017) of weather data (daily temperature, precipitation, humidity, 

sunshine, wind speed, cloud cover). 

❑ Information on crop-based land and soil requirements, agro climate requirement etc. 

❑ Limitation rating made on the basis of requirement of crop based 

❑ land and soil, agro climate, etc. in determining crop suitability. 

❑ Information on variety information, yield, life span of 76 crops. 

❑ Information on determining crop-based fertilizer recommendations and application 

methods. 

❑ Socio-Economic Data and Indicators for Assessing Financial Benefits in supporting the 

Introduction of Sustainable Crop Production Systems. 

❑ Upazila wise land type, roughness, soil texture, soil firmness, extractable juice status, 

water recession status, drainage status, soil reaction, salinity map. 

❑ Pre-Kharif, Kharif and Rabi production periods and cold and hot temperature zone map. 

❑ Upazila-wise administrative map (union and mauza boundaries, settlements, water 

bodies, rivers, pastures, etc.). 

❑ Digital Elevation Model (DEM), Satellite Imagery. 

❑ Existing land use map.
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Crop Zoning Information System 

 

 

 

➢ Edaphic Suitability Assessment     of Crop    

➢ Agro-climatic Suitability       Assessment of Crop 

➢ Bio-physical Suitability  Assessment of Crop 

➢ Potential Crops and their Extents 

➢ Cropping Patterns with GM and BCR 

➢ Fertilizer Recommendation 
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Khamari Mobile App 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

➢ Location based Crop Suitability    

➢ Location based Soil Fertility Status 

➢ Location based Fertilizer Recommendation 

➢ Cropping Patterns with GM and BCR 

➢ Crop Zones 

➢ Saved Information for Offline Viewing 
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Crop Suitability, Land Use, Crop Profitability, Fertilizer Recommendation 

 

 

 

Agri-advisory Portal 
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Future Plan 

 

➢ Develop National Crop Production Planning Tool using AI 

➢ Develop Khamari app as an integrated platform (one stop solution) 

➢ Updating of Land Use and Land Cover for all Upazila. 

➢ Capture LiDAR data for precise land height 

➢ Develop Satellite based crop monitoring and yield estimation 

➢ Institutionalize Demonstration Trial of Khamari app (through DAE). 

➢ Capacity Building of Manpower 

➢ Initiate Crop Modelling for Assessing Future Scenario of Crop Zoning 
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Applied GIS & Remote Sensing Techniques 
 

Instructor: Md. Abdus Shaker 

ICT, GIS & Remote Sensing Division (ICT), IWM 

 

1. Introduction to Applied GIS & Remote Sensing 

GIS and Remote Sensing are critical components of digital agriculture. These technologies 

support: 

• Crop monitoring & agricultural planning 

• Land suitability assessment 

• Spatial decision-making 

• Web-based information dissemination 

• Real-time data visualization for planners, scientists, and farmers 

This session focuses on modern GIS workflows, web GIS technologies, and an important 

national case study implemented in Bangladesh. 

 

2. GIS Data Types & Structure  

2.1 Vector Data 

Represents discrete features: 

• Points: tube-wells, sampling points, farm locations 

• Lines: canals, river networks, roads 

• Polygons: field boundaries, unions/upazilas, crop zones 

Used for administrative mapping, crop zoning, land parcels. 

2.2 Raster Data 

Represents continuous surfaces: 

• Satellite imagery 

• Soil moisture 

• Elevation (DEM) 

• Temperature/rainfall surfaces 

Used in suitability analysis, terrain evaluation, crop health studies. 

2.3 Coordinate Systems Used in Bangladesh 

• WGS84 Geographic (EPSG:4326): GPS, satellite-based data 

• UTM Zone 46N / 47N: accurate measurement & analysis 

 

3. Remote Sensing Fundamentals 

Remote Sensing provides regularly updated satellite-based information for agriculture. 

Key parameters: 

• Spatial resolution: how detailed (10m, 30m) 

• Spectral resolution: number of bands—crucial for vegetation, soil, water features 

• Temporal resolution: revisit time—important for crop monitoring 

• Radiometric resolution: sensitivity to brightness changes 
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Applications in agriculture: 

• Crop growth stage detection 

• Flood and drought impact mapping 

• Seasonal monitoring 

• Crop type identification 

• Land use and land cover changes 

 

4. Land Use / Land Cover (LULC) Mapping & Classification 

Types of Classification 

• Unsupervised: K-means, ISODATA 

• Supervised: SVM, Random Forest, Maximum Likelihood 

Uses in Agriculture 

• Mapping cultivated vs. fallow land 

• Monitoring encroachment 

• Crop type and cropping intensity 

• Seasonal land use trend analysis 

Web GIS Integration 

• Online LULC viewers 

• Change detection dashboards 

• Downloadable geospatial layers 

 

5. Spatial Interpolation Techniques 

Used to create continuous surfaces from point data (soil, rainfall, elevation). 

IDW 

• Simple and fast 

• Best for uniformly distributed samples 

Kriging 

• Statistical model for high accuracy 

• Used in groundwater and soil nutrient mapping 

Spline 

• Smooth surface generation 

• Elevation & moisture gradients 

Agricultural Use 

• Soil nutrient maps 

• Salinity interpolation 

• Rainfall surfaces 

• Groundwater depth mapping 
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6. Crop Zoning & Land Suitability Assessment 

Suitability analysis integrates multi-layer datasets to determine the best zones for crop 

cultivation. 

Key parameters used: 

• Soil properties (pH, OM, texture) 

• Topographic factors (slope, elevation) 

• Climate variables (rainfall, temperature) 

• Hydrological conditions 

• LULC and cropping patterns 

• Flood, drought, salinity risk 

7. Land Type Development  

Step-1: Spot Height With Map Unit 

• Collect spot heights 

• Apply interpolation (IDW) 

• Overlay map units 

• Extract elevation per unit 

• Generate elevation table & curve 

Step-2: Area Elevation 

• Sort by elevation 

• Calculate cumulative area 

• Determine cut-off thresholds 

• Assign Land Type (LL, MLL, MHL, HL) 

This supports flood depth analysis, cropping pattern selection, and land productivity planning. 

 

8. Web GIS Technologies 

8.1 What is Web GIS? 

A system that allows users to: 

• Access geospatial data online 

• View and analyze maps in real-time 

• Integrate multi-source datasets 

• Use interactive dashboards 

• Support multi-user decision-making 

 

8.2 Technologies Commonly Used for Smart Agriculture Systems 

Backend & GIS Server 

• PHP Laravel – API logic, business rules 

• GeoServer – publishing spatial data as WMS/WFS/WMTS 

• PostgreSQL + PostGIS – spatial database engine 
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Frontend Web GIS 

• OpenLayers – map rendering, advanced GIS tools 

• Leaflet – lightweight map viewer 

• Mapbox GL JS – high-performance vector rendering 

 

Mobile GIS Components 

• Android Native (Java/Kotlin) – Khamari Android 

• React Native – Khamari iOS 

• GPS-based data collection 

• Push notification support 

 

8.3 Typical Web GIS Architecture 

1. Client: Browser or mobile app 

2. Web Server: Laravel/PHP 

3. GIS Server: GeoServer 

4. Database: PostgreSQL/PostGIS 

5. Front-end Map Engine: OpenLayers 

Produces: 

• Maps 

• Charts & Reports 

• Suitability advisory 

 

9. Case Study: Development of Upazila Land Suitability Assessment and Crop Zoning 

System of Bangladesh 

(CZIIS – real national GIS application) 

 

9.1 Objective 

To provide crop suitability information to: 

• Farmers 

• Planners 

• Researchers 

• Policy makers 

To ensure: 

• Higher food production 

• Optimized crop rotation 

• Sustainable agricultural planning 

• Improved farmer income 
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9.2 GIS and RS Components of the Project 

 

1. Web GIS–based Upazila-level Crop Suitability Assessment System 

• Crop suitability maps 

• Multi-criteria analysis 

• Layer-based spatial comparison 

• Crop zoning advisory 

• Flood/salinity/drought risk overlays 

• Dynamic statistics and charts 

 

2. Mobile App Development – “খামারি” 

• Android version: Native (Java/Kotlin) 

• iOS version: React Native 

• Features: 

o Farmer location-based advisory 

o Crop recommendation 

o Weather info 

o Suitability by union/upazila 

o Notifications 

 

3. Agricultural Portal Development 

• Integrated dashboard 

• Geospatial data browsing 

• Suitability reports 

• LULC and soil data access 

• Administrative tools for DAE/BARC stakeholders 

 

9.3 Technology Stack (Open-Source) 

• PHP Laravel – application logic 

• PostgreSQL + PostGIS – spatial DB 

• GeoServer – geospatial data publishing 

• OpenLayers – interactive map interface 

• Android Native – field-level dissemination 

• React Native – iOS application 

• GEE (for preprocessing) – used in some RS workflows 
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9.4 Methodology  

 
Land Type Development  

Step-1: Spot Height With Map Unit 

• Collect spot heights 

• Apply interpolation (IDW) 

• Overlay map units 

• Extract elevation per unit 

• Generate elevation table & curve 
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Step-2: Area Elevation 

• Sort by elevation 

• Calculate cumulative area 

• Determine cut-off thresholds 

• Assign Land Type (LL, MLL, MHL, HL) 

 

This supports flood depth analysis, cropping pattern selection, and land productivity planning. 
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Backend System 

• Collect spatial and non-spatial datasets 

• Build centralized geodatabase 

• Preprocess layers (slope, LULC, soil, climate) 

• Generate suitability layers 

• Publish via GeoServer (WMS/WFS/WMTS) 

• Integrate into Web GIS portal 

 

 

Web Application Workflow 

1. User requests crop suitability 

2. Laravel processes request 

3. API requests map data from GeoServer 

4. OpenLayers displays map 

5. System generates reports/charts 

6. Mobile app fetches advisory 

 

Communication & Integration 

• SMS / Email integration for BARC 

• Mobile notification services 

• Downloadable reports: PDF, Excel, Maps 

 

 

10. Conclusion 

Participants gain: 

• Understanding of modern GIS & RS techniques 

• Clear idea of Web GIS technology 

• Insights into a national-level operational GIS system (CZIIS) 

• Practical knowledge on suitability, zoning, interpolation, LULC 

• Awareness of how GIS and RS support digital agriculture 

 

 

 

 
 


